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96 Executive summary

97  This Technical Specification (TS) document contains the final technical requirements for the Precision
98 Conformance Monitoring to be provided by project P10.04.02 for SESAR Step 1. The document
99 represents the deliverable D044 Conformance Monitoring System Requirements Phase 3.

100  This document includes:

101 o the refinement of technical requirements depicted in the deliverable 10.04.02 D08

102 Conformance Monitoring Requirements Phase 3 on the base of further clarification received
103 from other SESAR projects (like P05.07.02);

104 e some improvements related to enablers traceability;

105 e traceability and requirements adjustments and enhancement applied in consideration of the
106 final SPR [7] and OSED [8] provided by P04.07.02;

107 e traceability and requirements adjustments and enhancements applied in consideration of the
108 final OSED [11], SPR [12] and INTEROP [13] provided by P05.07.02.

109 e traceability and requirements adjustment and enhancement applied taking into account the
110 OSED [9] and SPR [10] provided by P04.07.02 for Free Route environment

111

112 To summarize, in comparison with the previous TS document (D08)

113 e For P04.07.02 OSED/SPR and P05.07.02 OSED/SPR/INTEROP already covered by D08 TS
114 requirements, traceability was updated;

115 ¢ Some requirements were added from scratch to fully cover the P04.07.02 OSED/SPR and
116 P05.07.02 OSED/SPR/INTEROP allocated to MONA,;

117 e Some requirements were added to cover OSED/SPR provided by P04.07.02 for free route
118 operations

119

120
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1 Introduction

This Technical Specification document contains the requirements under which Monitoring Aids
functional block has to perform.

The operational contributions considered for this TS document are P04.07.02 and P05.07.02 inputs.
The P04.07.02 is an operational project dealing with “Separation Task in En Route Trajectory based
environment”. The P05.07.02 instead is an operational project dealing with “Development of 4D
Trajectory-Based Operations for separation management using RNAV/PRNAV” focusing also on
introduction of MTCD-based tools in TMA airspace.

Consequently this TS document covers both En-Route (including Free routing aspects) and TMA
trajectory based environment requirements.

1.1 Purpose of the document

This Technical Specification (TS) document contains system requirements for the Conformance
Monitoring for the SESAR Step 1 capability in TMA, En-Route and Free Route Environment. The
relationship between the TS document and the other SESAR documents is illustrated in Figure 1.
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I (B.04.02))
1

I
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J_----—
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per Step

PRIMARY

I o - -

Figure 1: TS document with regards to the other SESAR deliverables

In support of the generation of the 10.04.02 Step 3 functional requirements, operational input was
received from the P04.07.02 and P05.07.02 projects. The P10.04.02 project received the deliverables
of the Operational Service and Environment Definition (OSED) [8] [9] [11], Safety and Performance
Requirements (SPR) [7] [10] [12] and Interoperability Requirements INTEROP [13] for
review/comments and implementation. The technical requirements presented in Chapter 3 of this
document have been obtained directly from those OSED, SPR and INTEROP.

The 04.07.02 OSED describes a concept of operations made up by the following three services with
different maturity levels (see [8] for detailed maturity):

- TRajectory Adjustment through Constraint of Time (TRACT)
- Conflict Detection and Resolution Aid to Planning Controller (CD&R aid to PC)

- Conflict Detection and Resolution Aid to Tactical Controller (CD&R aid to TC)

foaunding mambers

“ &> Avenue de Cortenbergh 100 | B -1000 Bruxelles

WWW . sesa "_|IJ.I.’.‘|.J 9 of 97

©OSESAR JOINT UNDERTAKING, 2015. Created by LEONARDO, INDRA, THALES, BELGOCONTROL/DSNA, NATMIG for
the SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged



149

150

151

152

153
154
155
156

157
158
159
160

161
162
163
164

165
166
167
168

169
170
171
172

173
174
175
176
177
178
179

180

181

182
183

184
185

186

187

The 04.07.02 OSED also specifies operational concepts dealing with:
e Monitoring vertical rate
e Monitoring Mode-S parameters against clearances
e Aspects relating to tactical and deviation trajectories

The 04.07.02 SPR documents describe the derived safety objectives and associated requirements for
the two, out of the three, services within project P04.07.02. The two services are: CD/R aid to PC and
CD/R aid to TC. It is expected that these requirements will form an input to the later stages of the
project and to support the growing maturity of these services.

Direct routing (for flights both in cruise and vertically evolving for cross ACC borders and in high &
very high complexity environments) and Free routing (for Flights both in cruise and vertically evolving
within low to medium complexity environments) aspects are specified in OSED [9] and SPR [10]
provided by P04.07.02

The 05.07.02 OSED document details the Preliminary (V2) Operational Concept for Step 1
Separation Management in TMA. It also includes the "Collaborative Control” thread of the project
P05.07.03 that focuses on Controller Team Organisation; specifically Roles and Responsibilities
within a Trajectory Based Operation within TMA Airspace.

The 05.07.02 SPR document provides the Safety and Performance Requirements for the Medium
Density/Medium Complexity and High Density/High Complexity operational environments, related to
the operational Services defined in the SESAR project 05.07.02 OSED document. It also includes a
summary of the Safety Assessment from which these requirements have been derived.

The 05.07.02 INTEROP document provides the Interoperability Requirements for air traffic services
(ATS) supported by data communications for SESAR Step 1 Separation Management in TMA. This
version is based on the OSED V2 and considers the results of the validation exercises (EXE-
05.07.02-VP-738, EXE-05.07.02-VP-740, EXE-05.07.02-VP-741 and EXE-05.07.02-VP-743).

The architecture required for Conformance Monitoring makes up high-level functional block
"MONitoring Aids" from P10.01.07 deliverable D120 "Technical Architecture Description (TAD) - Cycle
2015" [6]. In this TS document, the functionality is further broken down into the following functional
sub-blocks called “Eligibility”, "Lateral Conformance Monitoring”, "Vertical Rate Conformance
Monitoring”, “ CFL Conformance Monitoring”, " Level Bust’, “NoTT Monitoring”, “Potential
Coordination Failure”, "Mode-S DAP Conformance”, “SID and STAR Constraints”, Conformance
Monitoring related to Aircraft derived data” as illustrated by Figure 4.

1.2 Intended readership

The intended readership includes:

¢ All the operational projects linked to the 10.04.02 project (including P04.07.02, P05.07.02 and
P05.07.03) for coordination and validation purposes;

e Project in charge to perform validation across several concept functions/elements of En
Route operating context (P04.03);

e The ATC System Specification project (P10.01.07);

e Other WP10 projects for information and coordination purposes, including:

lounding mambers
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o0 P10.02.01 (The trajectory data are required inputs into the Conformance Monitoring
requirements defined in section 3 of this document, hence a common understanding
between the two projects is essential in order to achieve both a well-defined ground
system concept and a functioning prototype.);

0 P10.04.01 (The implementation of Conformance Monitoring requirements in section 3
are dependent from the CD&R requirements, a shared awareness between the two
projects ensures that the functionality complements each other as intended.);

0 P10.10.02 (Closed) and 10.10.03 (HMI requirements related to the P10.04 02 scope
have been included in previous TS document).

e Internal project members.

1.3 Inputs from other projects

The requirement set in this Technical Specification consists of the requirements specified in
P10.04.02 D08 ([5]) updated and aligned to 04.07.02 OSED/SPR ([7], [8], [9], [10]) and 05.07.02
OSED/SPR/INTEROP ([11], [12], [13]) needed to support Phase 2 and Phase 3 functionalities.

Another input for this document is D120 Technical Architecture Description (TAD) - Cycle 2015
provided by P10.01.07 [6]; indeed, the architecture required for Conformance Monitoring has been

derived from MONitoring Aids Functional Block depicted in this Technical Architecture Description
document.

1.4 Structure of the document

This document is structured as follows:

Chapter 1: Introduction

Chapter 2: General Functional Block Description

Chapter 3: Functional block Functional and non-Functional Requirements
Chapter 4: Assumptions

Chapter 5: References

Appendix A: Traceability of TS requirements with P04.07.02 OSED/SPR and P05.07.02
OSED/SPR/INTEROP

Appendix B: Subset of TS requirements linked to HMI functional block
Appendix C: Subset of 04.07.02 OSED and SPR allocated to Functional Block MONA by P10.01.07

Appendix D: Subset of P05.07.02 OSED, SPR and INTEROP allocated to Functional Block MONA by
P10.04.02 partners

Appendix E: Traceability of TS requirements to SESAR Solutions

Appendix F: Description of new functionalities developed in the top of FASTI baseline
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1.5 Requirements Definitions — General Guidance

All the requirements are provided in Chapter 3 of the document. The main sections are structured in
accordance with the SESAR TS Template ([1],[3]) and the Requirements and V&V Guidelines
provided by SJU ([2]) :

Section 3.1: Capabilities

Section 3.2: Adaptability

Section 3.3: Performance Characteristics

Section 3.4: Safety & Security

Section 3.5: Maintainability

Section 3.6: Reliability

Section 3.7: Functional block Internal Data Requirements
Section 3.8: Design and Construction Constraints
Section 3.9: Functional block Interface Requirements

The key functional requirements for Conformance Monitoring are provided in "Capabilities" section 3.1
structured as following:

Section 3.1: Capabilities

Section 3.1.1: Functional Requirements
Section 3.1.1.1: Eligibility Requirements
Section 3.1.1.2: Lateral Conformance Requirements
Section 3.1.1.3: Vertical Rate Conformance Requirements
Section 3.1.1.4: CFL Conformance Requirements
Section 3.1.1.5: Level Bust Requirements
Section 3.1.1.6: NoTT Conformance Requirements
Section 3.1.1.7: Potential Coordination Failure Requirements
Section 3.1.1.8: Mode-S DAP Conformance Requirements
Section 3.1.1.9: SID and STAR constraints conformance requirements
Section 3.1.1.10: Conformance monitoring requirements related Aircraft Derived Data

Interface requirements are provided in “Functional block Interface Requirements” section 3.9
structured as following:

Section 3.9: Functional block interface requirements

Section 3.9.1 System Interface Requirements
Section 3.9.1.1: Surveillance Interface Requirements
Section 3.9.1.2: Output Interface Requirements
Section 3.9.1.3: Input Interface Requirements

Section 3.9.2: HMI Requirements

As shown above, very general HMI requirements related to MONitoring Aids have been introduced a
dedicated section that was included in the Functional Block Interface Requirements..

Each requirement related to MONitoring Aids Functional Block has been numbered according to the
following template:

<Object type>-<Project code>-<Document code>-<Reference code>.<Reference number>
e.g. REQ-10.04.02-TS-nnnn.uuuu
0 REQ is the <Object type> (i.e. requirement),
0 10.04.02 is the <Project code> ,

0 TS is the <Document code> (i.e. technical specification),
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265

266

267

268

269

270

271

272
273
274
275

276
277

278
279

280

281

282
283
284

285
286
287
288

289
290

0 nnnn is the <Reference code>, sequence of 4 alphanumeric characters,

= Requirements from Phase 1 contain 0 in the first digit of the reference code

e REQ-10.04.02-TS-Onnn.uuuu

= Requirements from Phase 2 contain 2 in the first digit of the reference code

e REQ-10.04.02-TS-2nnn.uuuu

= Requirements from Phase 3 contain 3 in the first digit of the reference code

e REQ-10.04.02-TS-3nnn.uuuu

0 uuuu is the <Reference number>, sequence of 4 digits,

Requirements use the following recommended layout

Identifier

Requirement

Title

Status

Rationale

Category

Validation Method

Verification Method

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> Enabler code <Full>
<SATISFIES> <ATMS Requirement> INTEROP or SPR Requirement Identifier <Full>
<ALLOCATED TO> <Functional block> Functional block Identifier N/A
<APPLIES TO> <Operational Focus Area> | Operational Focus Area Identifier N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> Project Identifier N/A

Table 1: Requirements layout

1.6 Functional block Purpose

The MONitoring Aids functional block, which is the topic of this TS, includes a number of conformance
monitoring checks whose aim is improve flight adherence to planned trajectory.

The enablers for the requirements in this technical specification are primarily based on the relevant
Operational Improvements from the 04.07.02 OSED/SPR ([7], [8], [9], [10]) and 05.07.02
OSED/SPR/INTEROP ([11], [212], [13]), which are based on the Dataset 16 [4]. The enablers are
summarized in the following table:

Relevant Operational Improvement Enabler
CM-0205: Conflict Detection and Resolution ER ATC 157:

foaunding mambers
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291
292
293

294

295
296
297

298
299
300
301
302

303
304
305
306
307
308
309
310
311
312
313
314
315
316
317

318
319

in En-Route using trajectory data in ATC System Support for Medium-Term
Predefined and User Preferred Routes Conflict Detection and Resolution in Enroute
environments Airspace

CM-0207-A: Automated Ground Based Flight | ER_ATC_91: ATC System Support for
Conformance Monitoring in En Route in Step | Advanced Conformance Monitoring in En
1 Route Airspace1

CM-0208-A Automated Flight Conformance | APP_ATC_94: ATC tools in support of RNP
Monitoring in the TMA in Step 1 (e.g. RNP1, A-RNP, RNP APCH, etc) for
Approach/TMA

Table 2: Summary of Enablers for Conformance Monitoring

CM-0205 and CM-0207-A have been split in Dataset 16 [4] under the leadership of P04.02.

The scope of CM-0205 is now limited to what was validated in SESAR1, so will reach V3 in release 5.
The corresponding enabler is ER_ATC_157. A new OIl, CM-0209, was created for the part being
transferred to SESAR 2020.

Similarly, CM-0207-A is also limited to the SESAR 1 scope, and will also reach V3 as a result of the
release 5 exercises. Its enabler is ER_ATC_91 (new), which P10.04.02 technical specification will be
linked to. The SESAR 2020 part is in a new OIl, CM-0210, which is linked to enabler ER ATC 94. The
new enabler ER_ATC_91 is just monitoring aids, and P10.04.02 technical specification for SESAR 1
will link to it. This means changing the link from ER ATC 94.

The scope of CM-0208-A is also in the SESAR2020 scope. Its enabler is APP_ATC_94 which
addresses the functionality required in Approach/TMA; the ER ATC 94 is for the corresponding
Enroute enhancement. The rationale for creating separate enablers is to accommodate the different
timescales for the development of requirements in the two environments.
The Monitoring Aids functional block encompasses the following functions:

- Flight Trajectory deviation and conformance monitoring,

- Tactical Instruction and Clearance conformance monitoring,

- Flight progress monitoring and update,

- Reminder tools: reminder of instructions to be issued,

- Direct and Free Routing monitoring.
The trajectory prediction, included in P04.07.02 OSED/SPR and similarly in P05.07.02
OSED/SPR/INTEROP, are not in scope for this TS document. The computation of trajectories is
addressed by SESAR project 10.02.01 and will be available to the MONitoring Aid block as inputs
from the Trajectory Prediction & Management functional block. The Conflict Management is

addressed by SESAR project 10.04.01.

The MONA functional block does not include the actual HMI or displays either. Hence the detailed
visualization requirements are not in the 10.04.02 scope. Anyway some general HMI requirements

! ER_ATC_91 is the new enabler defined under the leadership of 10.01.07 and linked to CM-0207-A.
In this document the traceability will be modified by tracing the TS requirements to this new enabler.
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were included in this TS. Project 10.10.2 reviewed the general HMI requirements included in section
3.9.2 and provided some additional HMI requirements included in the section 3.9.2 as well. The HMI
prototypes will be developed based on these closely coordinated requirements.

1.7 Functional block Overview

This Technical Specification describes the ER/APP functional block "Monitoring Aids” that is included
in the high level illustration from the Technical Architecture Description - Cycle 2015 [6] and that has
been reproduced in the figure below.

[En-Route f Aaproach ATC Domain
System Functional Braakdown]
[ 2]
I 1 1 | ——+— [ 1 [ ]
Surveillance Sarety Nets Correlaton Code Flight Trajectory Coordination AIG Datalink cormict Monitoring
Management Management Planning - Pradiction and Transfer Seri ¥ gamant Aids
Lifecycle and
Managernen! - Management
Daia
Distnbution
A4 i \ / \ \
Leyacy GIG AIG Datalink GIG I0P Artival En.Route Sequence Local Air Controller Qperational Technical Support
Datalin‘k : Communicati Managerment Managerment and Flow Marager Trame Human Supenision Supenision Functions
Cammunicati ons Complexity Machine ERIAPP ATC ATC ERIAPP
ons Mzanagement Intaraction
=nt
ER/AFP

Figure 2: Functional Block Tree Diagram from EATMA

The main purpose of this functional block is to provide MONitoring Aids (MONA) assistance to the
ATCO(s).

In particular, Monitoring Aids encompasses the following functions:

Flight Trajectory deviation and conformance monitoring,
Tactical Instruction and Clearance conformance monitoring,
Flight progress monitoring and update,

Reminder tools,

Direct and Free Routing monitoring.

The Monitoring Aids will support ATCOs to detect and minimize trajectory non-conformances.

1.8 Glossary of terms

Term Definition Source

“ . e . 10.01.07.D120
Correlation period The “correlation period” is defined as the time between each tracker ATC System

update. - -
P Specification
lounding members
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Term Definition Source
10.01.07.D120
Correlated flight Flight plan with a planned trajectory correlated with a radar track ATC System
Specification
External Sector A sector outside of the airspace of responsibility assigned to the FASTI program
subject ATM system.
Internal Sector A sector inside of the airspace of responsibility assigned to the subject | FASTI program
ATM system.
Route The 2D trajectory of an aircraft, expressed as significant points, ATS EATM Glossary

routes or geographical points.

Sector A part of airspace controlled by a team of controllers, defined, notably, | EATM Glossary
by its geographical co-ordinates and its assigned radio frequency

State Vector A vector describing the state of an object in terms of its position co- EATM Glossary
ordinates, ground speed, course, accelerations and mode-of-flight

System Track A generic entity representing the surveillance data as transmitted by EATM Glossary
the surveillance system

Trajectory and Flight Related Terms

Trajectory The predicted behaviour of an aircraft. 4.7.2.D28

Note: the Trajectory is usually modelled as a set of consecutive OSED Glossary

segments linking waypoints and/or points computed by the aircraft
avionics (e.g. FMS) or by the ground system to build the vertical profile
and the lateral transitions.

Note: Each point is defined by a longitude, latitude, a vertical distance

and a time.
Tentative Trajectory | Tentative trajectories are created from another trajectory that is in 4.7.2.D28
operational use (Tactical, Planning or otherwise). They reflect OSED Glossary

tentative what-if flight data selected by the controller. If these
conditions are then committed the Tentative trajectory and the
associated data will be used to establish the new operational
trajectory. If the conditions are discarded then it will also be discarded.

Note: Tentative trajectories support What-If probing and are created
during this process.

Speculative A Trajectory that uses flight data other than those currently committed | 4.7.2. D280SED
Trajectory or tentatively selected (during a What-If Probing operation), by the Glossary
controller.
Note: Speculative Trajectories are produced for the purpose of What-
Else probing.
Tactical Trajectory | The Tactical Trajectory is calculated within a short look-ahead time 4.7.2.D28

(e.g. up to 15 minutes) during tactical ATC operations (sector planning | O©SED Glossary
layer). It therefore reflects an accurate view of the predicted flight
evolution, starting from the current flight position (generally, as
reported by surveillance), with low uncertainty and high precision. It is
kept up to date with all clearances, including tactical instructions.
During any open tactical manoeuvres it will also be reflecting those
temporary conditions.

It is usually determined with a fast update rate (e.g. 5 seconds) and
with an optimised Uncertainty calculation; to maximise response and
minimise the incidence of false warnings.

Note: The Tactical Trajectory supports the tactical ATC operations
when the flight follows its normal behaviour

[Tactical/Planning] | The Deviation Trajectory provides the predicted profile of the aircraft 4.7.2.D28
Deviation Trajectory | based on the observed behaviour, extrapolated from the particular OSED Glossary
deviation from the current clearance (or deviation from coordination
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Term

Definition

Source

constraint for Planning Deviation Trajectories).

Note: Deviation Trajectories are necessary for situations where non-
compliance with a flight's expected tactical or coordinated behaviour is
observed, with respect to an applicable tolerance threshold.

Deviation Trajectories support Tactical/Planner ATC operations when
the flight has deviated from its predicted behaviour.

The Tactical Deviation Trajectory is useful for a short prediction
horizon (e.g. 3-5 minutes).

A Planning Deviation Trajectory follows the cleared route of the flight,
irrespective of any coordination constraints (as the flight has been
observed to be deviating from these constraints).

During periods where a Deviation Trajectory is necessary it may also
be used by TC/PC CD&R Aid.

Subject Flight

A flight that has been explicitly selected by the Controller concerned.

4.7.2.D28
OSED Glossary

Subject Trajectory

The Trajectory of the Subject Flight

4.7.2.D28
OSED Glossary

Environmental Flight

A flight of interest to the Controller which is not the Subject Flight. The
Subject Flight will be checked for encounters with all Environmental
Flights.

4.7.2.D28
OSED Glossary

Context Flight

A flight that may need to be considered by the Planner ATCO when
making coordination choices for the Subject Flight, due to the flights’
anticipated vertical and lateral profiles.

Context Flights are those Environmental Flights that are involved in a
Planning Context Encounter with the Subject Flight.

Note: Context Flights may not currently be involved in a Planning
Encounter based on their current clearance or existing coordinated
levels.

4.7.2.D28
OSED Glossary

Environment
Trajectory

The Trajectory of an Environmental Flight

4.7.2.D28
OSED Glossary

Context Trajectory

Context Trajectories represent the expected utilisation of airspace by
each flight. Context Trajectories are built for the Subject Flight and
Environmental Flights.

Note: Context Trajectories are similar to Coordination Trajectories.
Each Context Trajectory maintains a single level and follows the lateral
profile of the Planned Trajectory. Context Trajectories are built at
every standard Flight Level from the entry-context level to the exit-
context level. The identification of entry-context and exit-context levels
is dictated by the information available in the system at the time of the
probe. They represent the lowest and highest level at which the flight
is anticipated to occupy in the sector.

The Origin and Termination points on Context Trajectories depend on
whether the flight is the Subject flight or an Environmental flight and on
the flight's anticipated vertical profile.

Example of Subject Flight Context Trajectories:

’ rT——
, exit tex

ntermediatg

context

reraft A / trajectories

-

/

ent context

SECTOR 1 SECTOR 2 SECTOR 3

Example of Environmental Flight Context Trajectories:

4.7.2. D28 OSED
Glossary

1
FLEIPTa Lo
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Term Definition Source

i intermediate
context

AlresoR 8 / trajectories
h entry ntext
SECTOR 1 SECTOR 2 SECTOR 3
User Preferred A preferred route that is provided by an Airspace User during the flight | 4.7.2. D28 OSED
Route planning and agreement phase. In Step 1 it may take advantage from | Glossary

Free Route Airspace (FRA) for optimum routings.

Note: A User Preferred Route may include published as well as non-
published points defined in latitude/longitude or point bearing/distance.
Such waypoints are inserted in the FMS for trajectory computation

Planning Trajectory Related Terms

Since the needs of the PC and TC differ in many respects, the trajectories produced to support the planning and
tactical roles are different.

Planning Trajectories are used to predict encounters between flights that are of concern to the PC. They take
account of the original flight plan, modified by agreed co-ordination constraints and standing agreements, but
possibly unconstrained by tactical instructions.

Planned Trajectory | The Planned Trajectory represents the stable medium to long term 4.7.2. D28 OSED
behaviour of the aircraft but may be inaccurate over the short term Glossary

where tactical instructions that will be issued to achieve the longer term
plan are not yet known.

It takes into account the planned route and requested vertical profile,
strategic ATC constraints, Closed Loop Instructions/Clearances, co-
ordination conditions and the current state of the aircraft. Assumptions
may be made to close Open Loop Instructions/Clearances issued by
tactical controllers.

It is calculated within the planning look-ahead timeframe, starting from
the Area of Interest of the unit concerned, or the aircraft’s current
position (whichever is later).

It is constrained during all phases of flight by boundary crossing targets
(e.g. standing agreements between the Units concerned).

Note: The Planned Trajectory supports the ATC planning operations. It
is used primarily to support data distribution within the system and in
the determination of the top of descent point. As such, uncertainty
does not need to be calculated for this trajectory. It is also used as the
starting point for derivation of more specific local ATC trajectories.

Planned Sequence | A Trajectory that is derived from the Planned Trajectory as it follows | 4.7.2. D28 OSED
Trajectory the vertical and lateral profile of the Planned Trajectory, truncated in Glossary
time to an adaptable parameter (e.g. 25 minutes).

Uncertainty is added (although the lateral uncertainty may be zero).

Note: The Planned Sequence Trajectory is used for the determination
of co-ordination levels and the sector penetration sequence.

It is used for both manual coordination and integrated coordination
purposes and may be used by the CD&R Aid (with the Planning
Separation) for traversals of the sector concerned (CD&R for entry and
exit to the sector are covered by the Coordination Trajectory).

[Entry/Exit] A Trajectory that is derived from the Planned Sequence Trajectory. It |4.7.2. D28 OSED
Coordination follows the lateral profile of the Planned Sequence Trajectory2 but Glossary

21t may be possible for the lateral profile of Coordination Trajectories to be altered from that of the Planning Trajectory to
take into account relevant Coordination Constraints applied at the boundary between two sectors.
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Term

Definition

Source

Trajectory
Or

[Entry/Exit]
Trajectory

maintains a specific coordination level relevant to the boundary
between two sectors. It represents the expected behaviour of the
aircraft according to the entry/exit co-ordination conditions.

Entry = A Trajectory that is built at levels associated with the sector
entry coordination for the flight.

Exit = A Trajectory that is built at levels associated with the sector exit
coordination for the flight.

Note: The Coordination Trajectory:
Supports both lateral and vertical boundary co-ordinations;
Can have the origin and end truncated (e.g. at sector boundaries);

Is necessary for predicting encounters with flights that are co-ordinated
with the sector but not yet in communication with that sector.

Because it is only needed for boundary crossing conditions it can have
a relatively short prediction horizon; typically up to the point where the
flight is assumed by the sector concerned.

TRACT Trajectory

A Trajectory that is derived from the Planned Trajectory. It is similar to
the Planned Sequence Trajectory in that it follows the vertical and
lateral profile of the Planned Trajectory, truncated in time to an
adaptable parameter (which is suitable for the TRACT process) and
uncertainty is included.

Note: It is used in support of the TRACT CD&R process.

4.7.2. D28 OSED
Glossary

Initial Reference
Business Trajectory
(iRBT for Step 1)

The representation of an airspace user's intention with respect to a
given flight, guaranteeing the best outcome for this flight (as seen from
the airspace user's perspective), respecting momentary and
permanent constraints.

The Reference Business Trajectory (RBT) refers to the Business
Trajectory during the execution phase of the flight. It is the Business
Trajectory which the airspace user agrees to fly and the Air Navigation
Service Providers (ANSP) and Airports agree to facilitate (subject to
separation provision)

Note: The iRBT is the Step 1 attempt to move towards the full SESAR
Reference Business Trajectory. It is shared between the Step 1 SWIM
subscribers and is updated from down-linked aircraft trajectory
updates. The extent to which this update, synchronisation and sharing
is possible within Step 1 will depend on progress made by enabling
projects. Likewise the extent to which guarantees can be made
concerning best outcome will be subject to the same Step 1
development progress and validation.

4.7.2. D28 OSED
Glossary

Constraint and Target Related Terms

CTO An ATM imposed time constraint over a point. 4.7.2. D28 OSED
Note: This constraint is sent by the ground system to the aircraft. Glossary
CTA/RTA An ATM imposed time constraint on a defined merging point 4.7.2. D28 OSED
associated with an arrival runway. Glossary
Note: This constraint is sent by the ground system to the aircraft.
Active A CTO or CTA or RTA that is currently taken into account by both, the |4.7.2. D28 OSED
CTO/CTA/RTA avionics (e.g. FMS) and the Ground Systems. Glossary
Note: It is considered to be active from the moment when both the air
and the Ground Systems have taken it into account, until the
application point of the constraint is over-flown or until it is cancelled in
the Air and the Ground systems.
Level Block A level or a range of levels that is blocked off to other traffic, e.g. 4.7.2. D28 OSED
crossers Glossary
launding meamber
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Term Definition Source
Target Time of An Arrival Time which is not a constraint but a progressively refined 4.7.2. D28 OSED
Arrival planning time that is used to coordinate between arrival and departure | Glossary

management applications. It is an ATM computed time.

Clearance and Instruction Related Terms

Open loop An ATC clearance or instruction where a full trajectory extrapolation 4.7.2. D28 OSED
Instruction/Clearance | beyond the point or segment(s) affected is not possible using the Glossary

normal prediction process, i.e. without special measures to assert a
closure condition (e.g. time limit on headings and most probable point
of return to original routing).

Open loop instructions/clearances can be cancelled by a Closed-loop
instruction/clearance .

Note: Most tactical instructions/clearances take this form; they include
heading (including track offset), level, and speed restrictions and
exceptionally could also cover rates of climb or descent.

Closed loop An ATC clearance or instruction where a full trajectory extrapolation 4.7.2. D28 OSED
Instruction/Clearance | beyond the point or segment(s) affected is possible using the normal Glossary
prediction process.

Note: A typical example is a direct route from one point to another on
the original route.

NFL, SFL The NFL is the cleared level that the aircraft will have when it will arrive | 4.7.2. D28 OSED
in the sector. The NFL is given by the upstream sector. The NFL is | Glossary
equal to the TFL of the upstream sector.

The SFL is the second level that permits to determine the interval of
flight levels in which the aircraft will arrive in the sector. So when
arriving in the sector the aircraft will be between the SFL and the NFL.

344
345 1.9 Acronyms and Terminology
346
Term Definition
2D, 3D, 4D Two Dimensional, Three Dimensional, Four Dimensional
4D TM Four dimensional Trajectory Management
4DTRAD Four Dimensional TRAjectory Data link
AIC Aircraft
ACC Area Control Centre
ADD Architecture Definition Document
ADEP Aerodrome of Departure
ADES Aerodrome of Destination
ADS-B Automatic Dependent Surveillance-Broadcast
ADS-C Automatic Dependent Surveillance-Contract
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Term Definition
AFL Actual Flight Level
AMAN Arrival MANager
ANSP Air Navigation Service Provider
APP Approach
ATC Air Traffic Control
ATCO Air Traffic Controller
ATIS Automatic Terminal Information Service
ATM Air Traffic Management
ATS Air Traffic Services
ATSU Air Traffic Services Unit
CCD Continuous Climb Departure
CDA Continuous Descent Approach
cD Conflict Detection
CD/R Conflict Detection and Resolution
CDO Continuous Descent Operations
CFL Cleared (Current) Flight Level
CFMU Central Flow Management Unit
CHMI Controller Human Machine Interface Management
CNS Communications, Navigation and Surveillance
COP Coordination Point
CPDLC Controller Pilot Data Link Communication
CTA Control Time of Arrival
CTO Control Time Over
CWP Controller Working Position
DAP Downlink Aircraft Parameter
DER Departure End of the Runway
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Term Definition

DFS Deutsche Flugsicherung GmbH (German ANSP)

DMAN Departure MANager

DOD Detailed Operational Description

DRA Direct-Route Airspace

DSNA Direction des Services de la Navigation Aérienne (Directorate Air Navigation
Services) (French ANSP)

EATMA European ATM Architecture

EPP Extended Projected Profile

ER En Route

ERATO En Route Air Trafic Organizer

ETA Estimated Time of Arrival

ETFMS Enhanced Tactical Flow Management System

ETO Estimated Time Over

EUROCAE EURopean Organization for Civil Aviation Equipment

FASTI First ATC Support Tools Implementation (programme)

FDMP Flight Data Manager Publisher

FDPS Flight Data Processing System

FIR Flight Information Region

FIS Flight Information Service

FL Flight Level

FMS Flight Management System

FP Flight Plan

FRA Free-Route Airspace

FTS Fast Time Simulation

GA General Aviation

GAT General Air Traffic
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Project ID 10.04.02

D44 - Consolid ] Conformance Monitoring System Requirements Edition: 00.04.00
Term Definition
HMI Human-Machine Interface
i4ADTM Initial 4-Dimensional (Trajectory Management)
IAS Indicated Air Speed
IBP Industry-Based Prototypes
ICAO International Civil Aviation Organisation
IFR Instrument Flight Rules
INTEROP Interoperability Requirements
IOP Interoperability
iRBT Initial Reference Business Trajectory
IRS Interface Requirements Specification
ITEC Interoperability Through European Collaboration
MONA MONitoring Aids
MSA Minimum Sector Altitude
MSP Multi Sector Planning
MTCD Medium-Term Conflict Detection
NATS National Air Traffic Services (UK ANSP)
NFL eNtry Flight Level
NoTT No Tactical Trajectory
OAT Operational Air Traffic
ol Operational Improvement
OSED Operational Service(s) Environmental Description
P04.07.02 Project 04.07.02. Separation Task in En Route Trajectory based environment
PC Planning Controller
PIR Project Initiation Report
RBT Reference Business Trajectory
RNP Required Navigation Performance
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Project ID 10.04.02

D44 - Consolidated Conformance Monitoring System Requirements Edition: 00.04.00
Term Definition
RTA Requested Time of Arrival
RTS Real Time Simulation
RVSM Reduced Vertical Separation Minimum
SDPDS Surveillance Data Processing and Distribution System
SESAR Single European Sky ATM Research Programme
SFL Supplementary Flight Level
SID Standard Instrument Departure
SJuU SESAR Joint Undertaking (Agency of the European Commission)
SPR Safety Performance Requirement
STAR STandard instrument ARrival
SUR Surveillance Data Processing and Distribution System
TAD Technical Architecture Description
TC Tactical Controller
TRACT TRajectory Adjustment through Constraint of Time
TCT Tactical Controller Tool
TMA Terminal Manoeuvring Area
TOAC Time Of Arrival Control
TOC Top Of Climb
TOD Top Of Descent
TP Trajectory Prediction
TP&M Trajectory Prediction and Management
TS Technical Specification
UAC Upper Airspace Control
UIR Upper Flight Information Region
V&V Validation and Verification
VFR Visual Flight Rules
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Project ID 10.04.02

D44 - Consolidated Conformance Monitoring System Requirements Edition: 00.04.00
VSP Variable System Parameter
XFL Exit Flight Level
WP Work Package
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Project ID 10.04.02
D44 - Consolidated Conformance Monitoring System Requirements Edition: 00.04.00

2 General Functional block Description

2.1 Context
The following figure gives an overview of the role of the Monitoring Aids Functional Block.
The information about each functional sub-block is detailed in section 2.6.1.

The Functional Blocks other than those in interface with MONA Functional Block are shown here for
information.

sd Monitoring Aids /
Monitoring Ai
, MoNA [ ___M onitoring Aids | ey
(20 S . FlightData _ __ _ «flow»
«flows é’adical Instruction & Clearance
«flow»
apsup ], DemieEnvonment 0z odsin | remyon
«flow» «flows
Flight Progress
e
SUR L _ _ AirSuneillance Data __ ~ «flow»
«flow»
Amval Sequence Data CHMI
AMAN T __Eq________> Manual Monitoring Aids Interaction
«flows 0 e =]
«flow»
Mona Configuration Data
SUBB R ————= e =i Monitoring Aids
«flow» Fe e e e e e S — S
«flow»
CoRR [ _ _TrackSFPL Comelation Data_ TBS Related Alerts
«flow» «flows

Figure 3: Monitoring Aids (MONA) Functional Block

As specified in 10.1.7 deliverable D120 “Technical Architecture Description - Cycle 2015 [6], the
Monitoring Aids functional block encompasses the following functions:

. Flight Trajectory deviation and conformance monitoring: detects if a controlled aircraft
deviates from its planned trajectory, notifying deviation warnings to the concerned sectors.

° Tactical Instruction and Clearance conformance monitoring: detects if a controlled aircraft
deviates from the issued clearance/instruction and notifies the current executive controller.

° Flight progress monitoring and update: this function keeps the trajectory updated along the
progress of the flight. It also detects certain events such as take-off, missed approach and landing.

. Reminder tools: reminder of instructions to be issued,

. Direct and Free Routing monitoring: detects if a controlled aircraft deviates from its planned

trajectory in a Free Route Environment (DRA/FRA), where it is hard to spot if a turn is due to a user
preferred planned route or to an unexpected manoeuver.
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372 2.2 Functional block Modes and States

373 N/A.

374 2.3 Major Functional block Capabilities

375  The requirements have been grouped according the following breakdown structure.

376 Functional requirements:

377 e Eligibility,

378 e Lateral conformance,

379 e Vertical Rate conformance,

380 e CFL conformance,

381 e Level Bust,

382 e NOTT monitoring,

383 e Potential Coordination Failure,

384 ¢ Mode-S DAP conformance,

385 e SID and STAR constraints conformance,

386 e Conformance monitoring requirements related to Aircraft Derived Data

387 Interface requirements:

388 e Surveillance
389 e Output
390 e Input
391 e HMI requirements
392 2.4 User Characteristics
393
ANSP / ATS Unit Air Traffic Controller
ACC, APP (Civ., Mil.) « Executive Controller X
¢ Planning Controller
ANSP / ATS Unit ATS Supervisor X
ACC, APP (Civ., Mil.)
394 Table 3: User Characteristics

395 User Characteristics
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The principle users of the Conformance Monitoring system are air traffic controllers. The system may
initially be used by both Executive and Planning Controllers. The Executive controller uses
Conformance Monitoring as a warning system of non-conformance with ATC instructions. In some
systems, the non-conformance with ATC instructions is detected through non-conformance with the
tactical trajectory. He can then adopt a tactical action (e.g. instruction to the pilot) to avoid the conflict
before the start of safety net. The planner controller usually uses Conformance Monitoring to update
mid-term strategy for traffic regulation / coordination.

Conformance Monitoring will be useful either in Approach or in En-Route.

We consider that the specified Conformance Monitoring is not intended for ground or runway
controllers (see Airport SESAR projects for these phases of flight).

Technical staff in charge of maintenance, supervision, offline parameterization, should be able to
monitor the Conformance Monitoring system by a basic graphical interface or a command line
interface.

User Expectations

From the air traffic controllers’ point of view some important expectations towards the monitoring
system are assumed to be the following (to be refined after input from ops projects and validation
feedback)

0 The main purpose is to relieve monitoring workload and free mental resources of the
controller for other tasks or more traffic.

o0 In order to relieve the monitoring load of the controller and make him rely on the system:

0 The system has to be reliable (if it is not reliable, controller has to keep monitoring
himself)

0 It has to be clear whether the system is correctly monitoring a flight or not (if it is
unclear whether the system is doing the job, controller himself has to keep
monitoring)

0 It has to be clear with regard to which profile the system is monitoring (if it is not clear
with regard to which profile the system is monitoring the controller cannot make good
use of surrounding airspace)

0 The system logic should be transparent. It should be clear why a warning is
presented or not. (if a warning is presented, controllers have to take corrective
actions and potentially instruct/explain to pilots, they can only do so when they
understand what went wrong)

0 The system should represent an understanding of “conformance/non-conformance”
which is shared to a reasonable extent by the controller.

0 The system should minimize false/nuisance warnings. (However, due to the safety
criticality of the system, when the controller relies on the system to do some
monitoring, it may be better to have some false warnings than missed ones).
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2.5 Operational Scenarios

Operational scenarios that illustrate the use of the Conformance Monitoring functionality are included
in Chapter 5 of the P04.07.02-D28, OSED_4 [8] and 04.07.02-D37 Free Route OSED [9]. The general
description of how Conformance Monitoring will be performed in TMA is included in the new SESAR
operating Method (Chapter 3.2 of the P05.07.02-D77 Preliminary V2 OSED for Step 1 [11]), also the
use cases for different density and complexity environments are depicted in Chapter 5 of the same
document.

2.6 Functional

2.6.1 Functional decomposition

The functional view of how the MONA functional block participates in realising the operational needs
has already been introduced in section 2.1.

As detailed in the Figure 3, the Precision Conformance Monitoring System has interfaces with the
following key external systems and actors:

- Surveillance Data Processing and Distribution System (SUR) — This part of ATM systems
provides an airspace situational awareness to user (air traffic controllers, ATM systems...).

- Trajectory Management and Flight Data Processing / Trajectory Management (TP&M) — This
part of ATM systems provides flight plan (planned route) for each controlled aircraft (via
CFMU, operator...) to user (ATM systems).

- Air Traffic Controllers (CHMI) — Some information are displayed at controller work positions
via HMI (warning of non-conformance, kind of deviations...). The operator can then amend its
control situation (new clearance, route...) through the HMI system.

A detailed overview of the other interfaces is available on Technical Specification - ATC System
Baseline documentations delivered by P10.01.07 [6]
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The Figure 4 shows instead the functional decomposition for Conformance Monitoring according to
Major Functional block Capabilities

(" ) ' )
Eligibility NoTT Monitoring
\. J \, J
4 ) e ™)
Potential

Lateral Confaituy Coordination Failure

\_ J \ 4
e ™ e ~
Vertical Rate Conformance Mode-S DAP
Conformance Monitoring Conformance
\ J \ 2
f ™ r A

CFL Conformance SID and ?TAR
Constraints
\. W, \_ .
s R r ™\
Conformance
Level Bust Monitoring related to

Aircraft Derived Data
\ J \

Figure 4: Conformance Monitoring Functional Breakdown

Eligibility — this function is responsible for determining the eligibility of flights for Conformance
Monitoring. The function may also offer the ability to exclude specific flights from monitoring.

Lateral Conformance Monitoring — this function provides warnings when a monitored flight does not
conform with lateral clearances and instructions (e.g. route and headings) The warnings are removed
when the lateral deviation is no longer present.

Vertical Rate Conformance Monitoring — this function provides a warning actual rate differs from
the cleared vertical rate by more than a parameter. The warnings are removed when the vertical rate
deviation is no longer present.

CFL Conformance Monitoring— this function provides a warning when the aircraft does not move
towards the CFL, or when the AFL of a levelled aircraft differs from the CFL by more than a threshold.
The warnings are removed when the CFL deviation is no longer present.

Level Bust Monitoring - this function provides a warning when the actual vertical rate exceeds a
rate threshold so that the aircraft is predicted to exceed the CFL. The warnings are removed when the
Level Bust deviation is no longer present.

NoTT Monitoring — this function provides a warning when there is no tactical or deviation trajectory
provided for a flight (and consequently there are not valid flight data available to be monitored).

Potential Coordination Failure Monitoring — this function provides a coordination failure warning
when difference between the planned entry/exit condition and the coordinated entry/exit condition
differs by more than a VSP threshold.
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Mode-S DAP Conformance Monitoring — this function provides warning when Mode-S selected
altitude differs from CFL. The warning is removed as soon as the Mode-S selected altitude becomes
equal to CFL.

SID and STAR Constraints Conformance Monitoring — this function provides warning when flying
on a SID or on a STAR at a waypoint configurable vertical constraints are violated.

Conformance Monitoring related to Aircraft Derived Data — this function provides warning when
CTA vs RTA deviation or ATA vs ETA deviation are detected and when there is a mismatch with the
aircraft derived information (e.g. actual IAS provided by aircraft via ADS).

2.6.2 Functional analysis
See 2.6.1

2.7 Service View

N/A
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3 Functional block Functional and non-Functional
Requirements

3.1 Capabilities

The following structure was shown in section 2.3. This chapter itemises the requirements associated
with each system capability in the list below.

Functional requirements:

o Eligibility

e Lateral conformance

o Vertical Rate conformance

e CFL conformance

e Level Bust

e NOTT conformance

e Potential Coordination Failure

e Mode-S DAP conformance

¢ SID and STAR constraints conformance

¢ Conformance monitoring requirements related to Aircraft Derived Data
Interface requirements:

e Surveillance

e Output

e Input

e HMI requirements

3.1.1 Functional Requirements

This section presents the functional requirements defined for Phase 2 and Phase 3.

3.1.1.1 Eligibility Requirements

3.1.1.1.1 Flights Trajectory Eligibility

[REQ]

Identifier REQ-10.04.02-TS-0001.0010

Requirement All correlated flights with a planned or a tactical trajectory shall be eligible for
Conformance Monitoring.
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524
525
526

527

528
529

530

Title Eligibility for conformance monitoring
Status <Validated >
Rationale Flight plan correlated with an ADS-C track, will be eligible too.
Planned trajectories modified upon controller clearances will be eligible too.
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.
Category <Functional>
Validation Method | <Live Trial>
<Real Time Simulation>
Verification <Test>
Method
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP_ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1200 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2003 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2004 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2010 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2002 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO0.2011 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1020 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRTA.0101 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FR00.0312 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRTA.1002 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-DR00.0310 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0001 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.01.03 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.1.1.1.2 Conformance Monitoring Processing

[REQ]

Identifier

REQ-10.04.02-TS-0001.0022

Requirement

For a flight eligible for conformance monitoring, the conformance monitoring
function shall compare track state vector of an aircraft with FP clearance data
when track data or FP clearance data are updated.

Title

Continuous monitoring of track data and clearance data

Status

<Validated >

Rationale

Track state vector is track data provided periodically by the surveillance. In the
event that the track data is not received for a time parameter (associated to the
track distribution period), the flight is considered as not-correlated (due to track
lost) so it is not subject to conformance monitoring.

The FP clearance data is provided as a trajectory or as an horizontal and a
vertical clearance. Both data defines two 4D positions to be compared to obtain
a conformance status.

The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category

<Functional>

Validation Method

<Live Trial>
<Real Time Simulation>

Verification Method

<Test>
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532
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[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP_ATC_94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1200 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2001 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2003 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2004 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2002 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR2.1140 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1020 <Full >
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRTA.0101 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRTA.1002 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.01.03 N/A
<CHANGED BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]

Identifier REQ-10.04.02-TS-0001.0026

Requirement

When flight is following a SID at or below 120 meters above DER (runway),
the conformance monitoring shall not detect any warning.

Title Conformance Monitoring at or below 120 meters above DER
Status <In Progress>
Rationale The inhibition of Conformance Monitoring in the area at or below 120 meters
above DER (Departure End of the Runway) will be performed through
geographical filters off line configured.
Implementation not requested in any validation exercise supported by
P10.04.02
Category <Functional>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method | <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2011 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]
Identifier REQ-10.04.02-TS-0001.0027

Requirement

When a flight is flying a SID between 120 m height above DER and MSA or
simply above MSA, the conformance monitoring shall detect warning
according to a dedicated vertical tolerance.

Title Conformance Monitoring warnings according to a dedicated vertical tolerance
Status <In Progress>
Rationale In case of flight above DER and MSA:

e Waypoint with a vertical constraint of “at ”, the vertical tolerance for
providing a warning shall be + 100 ft;
e Waypoint with a vertical constraint of “at or above”, the vertical
tolerance for providing a warning shall be - 100 ft;
e Waypoint with a vertical constraint of “at or below ”, the vertical
tolerance for providing a warning shall be + 100 ft.
In case of flight above MSA :
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e Waypoint with a vertical constraint of “at ”, the vertical tolerance for
providing a warning shall be + 150 ft;

e Waypoint with a vertical constraint of “at or above”, the vertical
tolerance for providing a warning shall be - 150 ft;

e Waypoint with a vertical constraint of “at or below ”, the vertical
tolerance for providing a warning shall be + 150 ft.
Implementation not requested in any validation exercise supported by

P10.04.02
Category <Functional>
Validation Method <Live Trial>

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2012 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO0.2013 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2014 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2015 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO0.2016 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2017 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.1.1.2 Lateral Conformance Requirements

[REQ]

Identifier

REQ-10.04.02-TS-0001.0023

Requirement

Upon a NoTT deviation detection, the Conformance Monitoring shall discard

any Route Deviation detection until NoTT deviation is removed.

Title Conformance monitoring discarding due to NoTT deviation detection

Status <Validated >

Rationale Route Deviation is discarded since no route information are available to check
conformance.
The requirement has been validated in EXE-04.07.02-VP-501 and EXE-
04.07.02-VP-741.

Category <Functional>

Validation Method

<Live Trial>
<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.4037 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.2004 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
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[REQ]

Identifier

REQ-10.04.02-TS-0001.0030

Requirement

When the track is outside of the flight path and the track is also outside the
radius around a waypoint of the flight route, the Conformance Monitoring
function shall detect a route deviation.

Title

Route Deviation Detection for a flight plan.

Status

<Validated >

Rationale

Track will be identified as outside of the flight path, if the distance between the
horizontal position of the track and its perpendicular projection on the planned
trajectory or tactical trajectory is bigger than a distance parameter.

Thresholds for distance between the horizontal position of the track and its
perpendicular projection on the (planned or tactical) trajectory and threshold for
radius around the waypoint can be defined as different parameters.

This requirements specifies the case when no heading clearance is on going;
in case there is a heading clearance applied to a flight, the conformance
monitoring detects a route deviation if the flight heading does not comply the
cleared one.

Conformance Monitoring will check route deviation at a rate of at least once per
a VSP configurable time.

The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category

<Functional>

Validation Method

<Live Trial>
<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP_ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2005 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1200 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRTA.0101 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FR00.0312 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-DR00.0310 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.01.03 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0050

Requirement

Upon controller entry, to a flight in lateral deviation, of a new assigned route,
heading with which the system track is in conformance, the conformance
monitoring shall remove the lateral deviation warning.

Title Removal of lateral deviation warning after new route assigned from the
controller

Status <Validated >

Rationale Note: baseline requirement, included because explicitly necessary for prototype
functionality
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method

<Live Trial>
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<Real Time Simulation>

Verification
Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED TO>
<APPLIES_TO>
<APPLIES_TO>
<APPLIES TO>

<CHANGED BECAUSE OF>

<ALLOCATED_TO>

[REQ]

Linked Element Type
<Enabler>

<Enabler>

<Enabler>

<ATMS Requirement>
<ATMS Requirement>
<ATMS Requirement>
<Functional block>
<Operational Focus Area>
<Operational Focus Area>
<Operational Focus Area>
<Change Order>
<Project>

Identifier

ER ATC 91

ER_ATC_157

APP ATC 94
REQ-04.07.02-SPR-CDR1.1210
REQ-05.07.02-OSED-MCMO.2005
REQ-04.07.02-SPR-FRTA.0101
Monitoring Aids (MONA)
OFA03.03.01

OFA03.03.02

OFA03.01.03

Change reference

10.04.02

Compliance
<Full>
<Full>
<Full>
<Full>
<Partial>
<Full>
N/A

N/A

N/A

N/A

N/A

N/A

Identifier

REQ-10.04.02-TS-0001.0051

Requirement

For a flight with a Route Deviation, the Conformance Monitoring shall remove
the route deviation if the track is inside the flight path.

Title Route Deviation Removal.

Status <Validated >

Rationale In this case Route Deviation is removed due to the track returning inside the
flight path (without any new clearance coming from the controller)
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method

<Live Trial>
<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2005 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRTA.0101 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FR00.0312 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-FRTA.1002 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-DR00.0310 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.01.03 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0450

Requirement

The Conformance Monitoring shall accept dedicated lateral threshold values to
apply for flights approved for particular PBN application.

Title Lateral tolerance considering PBN
Status <In Progress>
Rationale PBN applications are referred to instrument flight procedures (SID, STAR,

IAP). It will be possible to implement a set of procedures (i.e STARS) within a

TMA which not all of them require same PBN specification (e.g.one STAR may
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Project ID 10.04.02

D44 - Consolidated Conformance Monitoring System Requirements

Edition: 00.04.00

requires RNAV1 and another RNP2), The conformance monitoring should
accept different accuracy threshold depending on the accuracy of the required
specification. Obviously within the TMA can fly PBN and Non PBN aircraft

approved.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Functional>

Validation Method <Live Trial>

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO0.2018 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2024 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

3.1.1.3 Vertical Rate Conformance Requirements

[REQ]

Identifier

REQ-10.04.02-TS-0001.0141

Requirement

For a flight in vertical manoeuvre to a not reached CFL, the Conformance
Monitoring function shall detect a vertical rate deviation if the following

conditions are fulfilled:

a) No CFL deviation or level bust is detected, and
b) vertical latency time after a new vertical clearance has been elapsed, and
c¢) the new CFL is not reached, and
d) actual vertical rate is lower than the minimum vertical rate into the direction
to CFL, or actual rate differs from the cleared vertical rate by more than a

parameter.

Title Vertical Rate Deviation Detection

Status <Validated >

Rationale A CFL is reached when the difference between AFL and CFL is lower than a
threshold.
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method

<Live Trial>
<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP_ATC_94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3021 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3126 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
founding mambers

“ 9 Avenue de Cortenbergh 100 | B -1000 Bruxelles

R w0 SESAnUL e 38 of 97

©SESAR JOINT UNDERTAKING, 2015. Created by LEONARDO, INDRA, THALES, BELGOCONTROL/DSNA, NATMIG for
the SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint

with approval of publisher and the source properly acknowledged




576

577
578

579

580

581
582

583
584

[REQ]

Identifier

REQ-10.04.02-TS-0001.0142

Requirement

For a flight with a Vertical Rate Deviation, the Conformance Monitoring shall
discard the Vertical Rate Deviation, if any of the following conditions is fulfilled:
a) CFL is reached (difference between AFL and CFL is lower than a threshold)
b) actual vertical rate is higher than the minimum vertical rate into the direction
of the CFL, and actual rate differs from the cleared vertical rate less than a
parameter

Title Vertical Rate Deviation removal due to flight.

Status <Validated >

Rationale As a summary, a Vertical Deviation is removed when it is no longer detected,
so the detection conditions are no longer fulfilled. Consequently, conditions to
discard a Vertical Rate Deviation are the negative case of the Vertical Rate
Deviation Detection conditions.
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP_ATC_94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

3.1.1.4 CFL Conformance Requirements

[REQ]

Identifier

REQ-10.04.02-TS-0001.0151

Requirement

For a CFL previously reached, the Conformance Monitoring shall detect a CFL
deviation if the AFL differs from the CFL by more of a threshold.

Title CFL Deviation Detection for CFL Reached

Status <Validated >

Rationale A CFL is reached from the moment when the difference between AFL and CFL
is lower than a threshold.
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3022 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
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<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3126 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0152

Requirement

For a CFL not reached, the Conformance Monitoring shall detect a CFL
deviation if current AFL is outside a band level between the previous AFL and
the CFL.

Title CFL Deviation Detection for CFL Not Reached

Status <Validated >

Rationale A CFL is not reached from the moment that it is input to the moment when the
difference between AFL and CFL is lower than a threshold.
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3022 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3126 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0153

Requirement

For a flight with a CFL Deviation, if the AFL differs from the CFL by less than a
threshold, the Conformance Monitoring shall discard the CFL Deviation.

Title CFL Deviation removal due to flight return to cleared level.

Status <Validated >

Rationale The CFL Deviation may be removed due to a new CFL (CFL is updated) or due
to the flight returning to current CFL (AFL is updated). Both cases are included
in this requirement.
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

| Relationship | Linked Element Type | Identifier | Compliance
faunding mambers
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<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP_ATC_94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.1.1.5 Level Bust Requirements

[REQ]

Identifier

REQ-10.04.02-TS-0001.0181

Requirement

For a flight in vertical manoeuvre close to the CFL, the Conformance
Monitoring shall detect a Level Bust deviation if the actual vertical rate exceeds
a rate threshold and no CFL Deviation is detected.

Title Level Bust Deviation Detection

Status <Validated >

Rationale A flight is considered in a vertical manoeuvre close to the CFL, when the
difference between AFL and CFL is lower than an additional threshold. This
threshold is independent of the reached CFL defined in other requirements.
The requirement has been validated in EXE-04.07.02-VP-501 and EXE-
04.07.02-VP-741.

Category <Functional>

Validation Method

<Live Trial>
<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC_91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3023 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3126 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0182

Requirement

For a flight with a Level Bust Deviation, if actual vertical rate is less than an
threshold, the Conformance Monitoring shall discard the Level Bust Deviation.

Title

Level Bust Deviation removal due to vertical rate correction.

Status

<Validated >

Rationale

As a summary, a Level Bust Deviation is removed when it is no longer
detected, so the detection conditions are no longer fulfilled. Consequently,
conditions to discard a Level Bust Deviation are the negative case of the Level
Bust Deviation Detection conditions.
The requirement has been validated in EXE-04.07.02-VP-501 and EXE-

04.07.02-VP-741.

Category

<Functional>
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Validation Method <Live Trial>
<Real Time Simulation>
Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.1.1.6 NoTT Conformance Requirements

[REQ]

Identifier

REQ-10.04.02-TS-0001.0191

Requirement

The Conformance Monitoring shall detect a NoTT Deviation if
a) no valid route information is available for a flight;

or

b) the aircraft is beyond or before its cleared (filed) route.

Title NoTT Deviation Detection

Status <Validated >

Rationale In case of NOTT deviation, tactical trajectory cannot be calculated because of
missing input data.
A flight does not have valid flight data for monitoring when no tactical or
deviation trajectory is available. If any of them is calculated, the NoTT deviation
is not detected.
The requirement has been validated in EXE-04.07.02-VP-501.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC_91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3024 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.2004 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0194

Requirement

For a flight with a NoTT deviation detected, the Conformance Monitoring shall
discard the NoTT Deviation previously detected, if the flight has a Tactical
Trajectory or a Deviation Trajectory, and the flight is inside the cleared (filed)
route.

Title NoTT Deviation removal
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Edition: 00.04.00

Status <In Progress>

Rationale The conditions for NoTT Deviation removal are the opposite (in a logical sense)
of the conditions NoTT Deviation detection.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.1.1.7 Potential Coordination Failure Requirements

[REQ]

Identifier

REQ-10.04.02-TS-0001.0170

Requirement

The conformance monitoring shall detect an entry/exit coordination failure
when the difference between the planned entry/exit condition and the
coordinated entry/exit condition differs by more than a VSP time or level
threshold.

Title Coordination conditions failure warning

Status <Validated >

Rationale Entry/exit condition (e.g. COP XFL)
The requirement has been validated in EXE-04.07.02-VP-501 and EXE-
04.07.02-VP-741.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <Enabler> APP_ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR2.1240 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0175

Requirement

When an entry and/or exit coordination failure is detected, the conformance
monitoring shall issue the warning to the exit sector CWP and/or entry sector

CWP.

Title

Entry/Exit coordination failure
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Status <Validated >

Rationale The entry/exit coordination failure warning will have to be distributed and
displayed to the CWP associated to the interested entry/exit sectors.
The requirement has been validated in EXE-04.07.02-VP-501 and EXE-
04.07.02-VP-741.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR2.1240 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR2.1250 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.1.1.8 Mode-S DAP Conformance Requirements

[REQ]

Identifier

REQ-10.04.02-TS-0001.0161

Requirement

Upon a latency time after a new vertical clearance has been elapsed, if the
Mode S Selected Altitude differs to CFL, the Conformance Monitoring function
shall detect a Mode S Altitude Deviation.

Title Mode S Selected Altitude Deviation Detection with clearance latency.

Status <Validated >

Rationale In order to avoid that Mode S Selected Altitude Deviation is raised every time a
new CFL is input, a time latency condition is added.
The requirement has been validated in EXE-04.07.02-VP-501 and EXE-
04.07.02-VP-741.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC_91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1220 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A
[REQ]

Identifier REQ-10.04.02-TS-0001.0163

Requirement

For a flight with a Mode S Altitude Deviation, if the Mode S Selected Altitude is
equal to CFL, the Conformance Monitoring shall remove the Mode S Altitude
Deviation.

Title Mode S Selected Altitude Deviation removal
Status <Validated >
Rationale Deviation removal condition may be achieved due to a CFL updated or due to
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a Mode S Selected Altitude, both cases will achieve the deviation removal.
The requirement has been validated in EXE-04.07.02-VP-741.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<ALLOCATED_TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]

Identifier REQ-10.04.02-TS-0001.0165

Requirement Upon a latency time after a Mode S Selected Altitude update has been

elapsed, if the Mode S Selected Altitude differs to CFL, the Conformance
Monitoring function shall detect a Mode S Altitude Deviation.

Title Mode S Selected Altitude Deviation Detection with pilot latency.

Status <Validated >

Rationale In order to avoid nuisance Mode S Selected Altitude Deviation if the pilot
enters the new clearance faster than the controller, a time latency condition is
added.

The requirement has been validated in EXE-04.07.02-VP-501 and EXE-
04.07.02-VP-741.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1220 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

3.1.1.9 SID and STAR constraints conformance requirements

[REQ]

Identifier REQ-10.04.02-TS-0001.0024

Requirement For a flight cleared to IAF, the Conformance Monitoring shall detect a vertical
deviation, if the AFL is lower than the vertical constraint associated to the IAF
more than an adapted parameter.

Title Vertical deviation when AFL is lower than the vertical constraint

Status <In Progress>

Rationale A flight cleared direct to IAF should not descend below the level defined for the
IAF.
Implementation not requested in any validation exercise supported by
P10.04.02
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Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO0.2010 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]

Identifier REQ-10.04.02-TS-0001.0400

Requirement For a "at or above" vertical constraint associated to an STAR waypoint, the

Conformance Monitoring shall detect a STAR constraint deviation, if the track
is inside the radius around the STAR waypoint, the STAR waypoint is not
overflown and the AFL is lower than the vertical constraint in more than an
adapted parameter.

Title STAR constraint at or above

Status <In Progress>

Rationale This monitoring is to detect if the flight is not going to fulfil the vertical
constraint.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP_ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2007 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2008 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2009 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

3.1.1.10 Conformance monitoring requirements related to Aircraft
Derived Data

[REQ)

Identifier REQ-10.04.02-TS-0001.0180

Requirement All detected deviations shall be available to be displayed as non-conformance
warnings in the respective position sector.

Title Displaying availability of nhon-conformance warnings.

Status <Validated >

Rationale All detected deviations has to be available to be displayed, that does not mean

than all detected deviation has to be displayed (may be configured, adapted, or
manually inhibited).

The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method | <Live Trial>
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Project ID 10.04.02

D44 - Consolidated Conformance Monitoring System Requirements

Edition: 00.04.00

<Real Time Simulation>
Verification <Test>
Method
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC_91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2005 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1190 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A
[REQ]
Identifier

REQ-10.04.02-TS-0001.0190

Requirement

The type of the detected deviation shall be available for presentation for a
displayed non-conformance warning to the respective position sector.

Title Availability of type of trajectory deviation for non-conformance warning.

Status <Validated >

Rationale The precise non-conformance warnings to be defined and which deviations
generate each warning display are implementation.
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method

<Live Trial>
<Real Time Simulation>

Verification <Test>

Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1190 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
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Identifier

REQ-10.04.02-TS-0001.0230

Requirement

Whenever conformance monitoring warning is provided, it shall be made
available for presentation to the respective position sector, until it is removed by

the Conformance Monitoring function.

Title Presentation and removal of conformance warning

Status <Validated >

Rationale The non-conformance warning to be distributed, displayed and removed to the
interested position sector
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method | <Live Trial>
<Real Time Simulation>

Verification <Test>

Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP_ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2005 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2006 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]

Identifier

REQ-10.04.02-TS-0003.0240

Requirement

When a CTA vs RTA deviation is detected, the conformance monitoring shall
provide a lighting warning to the CWP

Title Presentation of CTA vs RTA deviation
Status <In Progress>
Rationale The non-conformance warning to be distributed, displayed and removed to the
interested position sector.
Implementation not requested in any validation exercise supported by P10.04.02
Category <Functional>
Validation Method | <Live Trial>
<Real Time Simulation>
Verification <Test>
Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2019 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0003.2031 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]
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Identifier

REQ-10.04.02-TS-0001.0410

Requirement

When CTA and RTA information are available, the conformance monitoring
shall generate a warning when, over a configurable waypoint, aircraft CTA
differs from RTA more than a configurable time parameter, at each correlation
period cycle.

Title CTA vs RTA deviation

Status <In Progress>

Rationale The conformance monitoring should consider also the information which come
from the aircraft which should be used for improving Conformance functionality,
The tolerance to raise this warning is constrained by the correlation period, but
the correlation period can be synchronized on sensor (generally 4 seconds in
approach), periodic (each x seconds) or aperiodic(each update of track).
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Functional>

Validation Method <Live Trial>

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO0.2019 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2020 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0003.2031 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_ BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0430

Requirement

When Aircraft Derived Data are available, the conformance monitoring should
detect a IAS deviation warning if the actual IAS (provided by the aircraft)

differs from cleared IAS.

Title Actual IAS vs Cleared IAS deviation

Status <In Progress>

Rationale Actual IAS will be provided by aircraft via ADS.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Functional>

Validation Method <Live Trial>

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2022 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0460

Requirement

When Aircraft Derived Data or EPP data are available, the conformance
monitoring shall compare the future positions to the reference trajectory and in
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case of deviation issue a warning indicating " in "XXX" minutes, "Flight ID" shall
be deviated from the latest clearance.

Title Aircraft Derived Data or EPP usage

Status <In Progress>

Rationale It is expected that conformance monitoring tool not just comparing present
position against reference trajectory, but also future positions.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2025 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO0.2021 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.2 Adaptability

No adaptability system requirements can be derived at this time. This section can be revised when
more information becomes available.

3.3 Performance Characteristics

[REQ]

Identifier

REQ-10.04.02-TS-0001.0470

Requirement

The conformance monitoring shall be able to manage at least 200 flights per
control area (TMA or ACC).

Title Conformance monitoring capacity

Status <Validated >

Rationale The number of managed flights per control area includes flights under control
(in live status) or within the look ahead time per each control area. Capacity for
future flights (not within the look ahead time) or additional control areas are
outside this number.
The requirement has been validated in EXE-04.07.02-VP-741.

Category <Functional>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR1.3020 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
founding mambers
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3.4 Safety & Security

The requirements included in this section have been derived from the latest available P04.07.02 D30
Preliminary Safety and Performance Requirements for MTCD/TCT_4. This section will be revised
when some more information becomes available.

[REQ]

Identifier REQ-10.04.02-TS-0002.0100

Requirement The probability of Loss of TC-Aid shall be no more than 3.33E-07 per flight
hour.

Title Acceptability of Loss of TC-Aid

Status <In Progress>

Rationale Safety requirement is defined in relation to the safety objectives derived from
the Failure Case Analysis workshop (P04.07.02 Task 93).
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Safety>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Analysis>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <Enabler> ER ATC 157 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.2030 <Full>

<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A

<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A

<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A

<ALLOCATED_TO> <Project> 10.04.02 N/A

[REQ]

Identifier REQ-10.04.02-TS-0002.0200

Requirement The probability of Delay of the TC-Aid shall be no more than 3.33E-07 per flight
hour.

Title Acceptability of Delay of TC-Aid

Status <In Progress>

Rationale Safety requirement is defined in relation to the safety objectives derived from

the Failure Case Analysis workshop (P04.07.02 Task 93).
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Safety>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Analysis>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.2070 <Full>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.02 N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]
Identifier REQ-10.04.02-TS-0002.0300
Requirement The probability of Corruption (Undetected) of the TC-Aid shall be no more than
3.33E-07 per flight hour.
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Title Acceptability of Corruption (Undetected) of TC-Aid

Status <In Progress>

Rationale Safety requirement is defined in relation to the safety objectives derived from
the Failure Case Analysis workshop (P04.07.02 Task 93).

Implementation not requested in any validation exercise supported by
P10.04.02

Category <Safety>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Analysis>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <Enabler> ER ATC 157 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.2110 <Full>

<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A

<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A

<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A

<ALLOCATED_TO> <Project> 10.04.02 N/A

[REQ]

Identifier REQ-10.04.02-TS-0002.0400

Requirement The probability of Corruption (Detected) of the TC-Aid shall be no more than
1.00E-05 per flight hour

Title Acceptability of Corruption (Detected) of TC-Aid

Status <In Progress>

Rationale Safety requirement is defined in relation to the safety objectives derived from

the Failure Case Analysis workshop (P04.07.02 Task 93).
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Safety>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Analysis>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance

<SATISFIES> <Enabler> ER_ATC_157 <Full>

<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.2140 <Full>

<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A

<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A

<APPLIES_TO> <Operational Focus Area> OFA03.03.02 N/A

<ALLOCATED TO> <Project> 10.04.02 N/A

[REQ]

Identifier REQ-10.04.02-TS-0002.0500

Requirement The frequency of occurrence of detected corruption of input data from
Trajectory Deviation Detection function shall not be greater than 0.4x10-7(/flt
hr)

Title Frequency of detected corruption of input data

Status <In Progress>

Rationale Safety requirement for 4D Trajectory-Based Operations for separation

management using RNAV/PRNAYV.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Safety>

Validation Method <Live Trial>
<Real Time Simulation>

“ &> Avenue de Cortenbergh 100 | B -1000 Bruxelles
R w0 SESAnUL e 52 of 97
©SESAR JOINT UNDERTAKING, 2015. Created by LEONARDO, INDRA, THALES, BELGOCONTROL/DSNA, NATMIG for
the SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged




717
718

719
720

721
722

723

724

725
726

727
728

729
730

731
732

733

734

| Verification Method | <Analysis>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR1.2030 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR1.2080 <Partial >
<ALLOCATED_TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A

[REQ]

Identifier REQ-10.04.02-TS-0002.0600

Requirement The frequency of occurrence of undetected corruption of input data from
Trajectory Deviation Detection function shall not be greater than 0.4x10-7(/flt
hr)

Title Frequency of undetected corruption of input data

Status <In Progress>

Rationale Safety requirement for 4D Trajectory-Based Operations for separation
management using RNAV/PRNAYV.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <Safety>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method | <Analysis>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR1.2030 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR1.2080 <Partial >
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.02 N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.5 Maintainability

Requirements related to Maintainability have not been derived from 04.07.02 OSED. This section will
be revised when some more information will be available.

3.6 Reliability

Requirements related to Reliability have not been derived from 04.07.02 OSED. This section will be
revised when some more information will be available.

3.7 Functional block Internal Data Requirements

These requirements are internal to the design of the prototypes and will be detailed when 04.07.02
performance requirements will be available.

3.8 Design and Construction Constraints

In line with the 10.1.7 ATC system specification, the following approach will be used.
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The System shall be designed as a modular and open architecture based on defined and established
industry standards.

The software design shall adopt a hierarchy scheme in form of a set of application software layers
that are at different abstraction levels.

It shall be possible to integrate further additional components that may be defined in subsequent
development steps.

3.9 Functional block Interface Requirements

This section contains the specification of requirements for interfaces among different functional
blocks.

In particular it contains system interface requirements distributed in Surveillance, Output and Input
Interface requirements.

This section includes also HMI requirements which introduces high level specifications related to
interface among MONA and CHMI functional blocks.

3.9.1 System Interface Requirements

The sections below present the interface requirements identified for the Monitoring Aid functional
block.

3.9.1.1 Surveillance Interface Requirements

[REQ_]_

Identifier REQ-10.04.02-TS-0001.0320

Requirement The Conformance Monitoring shall process Track Information; received Track
Information has to be QNH corrected in order to be compared with vertical
clearances

Title Processing of track information

Status <Validated >

Rationale The minimum surveillance information used for each received track by

Conformance Monitoring are

Track position (Latitude/longitude, Altitude)

Track associated time: last update

The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method | <Live Trial>
<Real Time Simulation>

Verification <Test>
Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.2005 <Partial>
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Project ID 10.04.02
D44 - Consolidated Conformance Monitoring System Requirements

Edition: 00.04.00

<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2001 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0001 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0006 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0007 <Partial >
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A
755
756  3.9.1.2 Output Interface Requirements
757 [REQ]
Identifier
REQ-10.04.02-TS-0001.0330
Requirement The Conformance Monitoring shall at least produce the following Deviation
Detection data items in case of a non-conformance warning:
e Type of non-conformance
¢ Non-conformance measure
e Time of non-conformance
Title Data items from a non-conformance warning
Status <Validated >
Rationale Type of non-conformance (e.g. lateral conformance, vertical rate conformance),
Non-Conformance Measure (e.g. lateral left deviation, lateral right deviation),
Time of non-conformance (when the non-conformance starts)
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.
Category <Functional>
Validation Method | <Live Trial>
<Real Time Simulation>
Verification <Test>
Method
758
759 [REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1190 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1150 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0002 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0003 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
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<CHANGED BECAUSE OF>

| <Change Order> | Change reference [ N/A

[REQ]

Identifier

REQ-10.04.02-TS-0001.0340

Requirement

Upon detection of a NoTT Deviation, a Route Deviation, a Speed Deviation, a
CFL Deviation, a Vertical Deviation or a Level Bust Deviation for a flight,
Conformance Monitoring shall report the deviation detected in order to trigger
the deviation trajectory calculation for the flight.

Title Conditions for Deviation Trajectory calculation trigger
Status <Validated >
Rationale Any deviation will trigger the Deviation Trajectory instead the Tactical Trajectory
calculation. This trigger will include whose deviations are detected in order to be
applied in the deviation trajectory calculation.
The requirement has been validated in EXE-04.03-VP-798.
Category <Functional>
Validation Method | <Live Trial>
<Real Time Simulation>
Verification <Test>
Method
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP_ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1120 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1130 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1140 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1150 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1160 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1170 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR2.1140 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1150 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1160 <Full >
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0003 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]
Identifier

REQ-10.04.02-TS-0001.0341

Requirement

If all deviations for a flight are removed, the Conformance Monitoring shall report
the absence of deviations to the TP&M for triggering the tactical trajectory
calculation for the flight.

Title Tactical Trajectory Calculation Trigger due to absence of deviation

Status <Validated >

Rationale Conformance monitoring will report the absence of vertical and/or lateral
deviation (both or any of them) to TP&M in order to calculate the tactical
trajectory.
The requirement has been validated in EXE-04.07.02-VP-501 and EXE-04.03-
VP-798.

Category <Functional>

Validation Method | <Live Trial>
<Real Time Simulation>

Verification <Test>

Method
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Project ID 10.04.02

D44 - Consolidated Conformance Monitoring System Requirements

[REQ Trace]

Edition: 00.04.00

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1180 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1160 <Full >
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

3.9.1.3 Input Interface Requirements

[REQ]

Identifier

REQ-10.04.02-TS-0001.0310

Requirement

The Conformance Monitoring shall receive and use the planned trajectory (and
every update of it) and controller clearances data for a flight as long as a

system flight plan is available.

Title Processing of planned trajectory and controller clearances data
Status <Validated >
Rationale The trajectory information used by Conformance Monitoring is implementation
detail. For example list of points with:
= Latitude/Longitude
= Level
= Time
= Velocity: horizontal, vertical
= Associated constraints, if any
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.
Category <Functional>
Validation Method | <Live Trial>
<Real Time Simulation>
Verification <Test>
Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2004 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2023 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1200 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR2.1140 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1140 <Full >
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0001 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0004 <Full >
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0005 <Full >
<ALLOCATED_TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
[REQ]

Identifier

REQ-10.04.02-TS-0001.0350

Requirement

The Conformance Monitoring shall accept vertical and lateral threshold values.
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Title Threshold inputs.

Status <Validated >

Rationale Vertical and lateral threshold represents threshold inputs taken into account to
compute deviation
The requirement has been validated in EXE-04.07.02-VP-501, EXE-04.07.02-
VP-741 and EXE-04.03-VP-798.

Category <Functional>

Validation Method | <Live Trial>
<Real Time Simulation>

Verification <Test>

Method

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3020 <Partial>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3021 <Partial>
<ALLOCATED TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
[REQ]

Identifier REQ-10.04.02-TS-0001.0360

Requirement

The Conformance Monitoring shall accept acknowledgements from the HMI in
response to deviation detections.

Title Acknowledgement inputs.
Status <In Progress>
Rationale Acknowledgments from HMI will allow to give an indication that a kind of
response has been given to a detected deviation.
Implementation not requested in any validation exercise supported by P10.04.02
Category <Functional>
Validation Method | <Live Trial>
<Real Time Simulation>
Verification <Test>
Method
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC_91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0005 <Partial>
<ALLOCATED_TO> <Functional block> Monitoring Aids (MONA) N/A
<APPLIES_TO> <Operational Focus Area> | OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> | OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A

3.9.2 HMI Requirements

This section shows general HMI requirements related with MONitoring Aids which have been

identified.
[REQ]

Identifier

REQ-10.04.02-TS-0002.0240

Requirement

The CWP shall allow the controller to assign a new route or heading with
which the system track is in conformance in order to remove the deviation
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warning for a flight in lateral deviation

Title Lateral deviation warning removal
Status <Validated >
Rationale Related to REQ-10.04.02-TS-0001.0050. If a flight in lateral deviation
becomes in conformance with a new route assignment, the lateral deviation
warning shall be removed by the conformance monitoring system (and,
consequently, not displayed anymore).
The requirement has been validated in EXE-04.07.02-VP-741.
Category <HMI>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER_ATC_91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1140 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1150 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0005 <Partial>
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<APPLIES_TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.02 N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0002.0250

Requirement

The CWP shall display a warning to the exit and entry sector of a flight when
a coordination failure is detected.

Title Display of an Entry/Exit coordination failure
Status <Validated >
Rationale Related to REQ-10.04.02-TS-0001.0175. The entry/exit coordination failure
warning will have to be distributed and displayed to the CWP associated to
the interested entry/exit sectors.
The requirement has been validated in EXE-04.07.02-VP-741.
Category <HMI>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR2.1240 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR2.1250 <Full>
<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.03.02 N/A
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<ALLOCATED TO> <Project> 10.04.02 N/A

[REQ]

Identifier

REQ-10.04.02-TS-0002.0260

Requirement

The CWP shall allow the Controller to acknowledge in response to deviation
detections.

Title

Controller acknowledge to deviations

Status

<In Progress>
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Rationale

Acknowledgments from HMI will allow to give an indication that a kind of
response has been given to a detected deviation. Related to REQ-
10.04.02-TS-0001.0360.

Implementation not requested in any validation exercise supported by
P10.04.02

Category

<HMI>

Validation Method

<Live Trial>
<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED TO>
<ALLOCATED_TO>
<APPLIES TO>
<APPLIES TO>

[REQ]

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-05.07.02-INTEROP-0030.0005 <Partial>
<Enabler> ER_ATC 91 <Full>
<Enabler> ER ATC 157 <Full>
<Functional block> Controller HMI Management N/A
<Project> 10.04.02 N/A
<Operational Focus Area> OFA03.03.01 N/A
<Operational Focus Area> OFA03.03.02 N/A

Identifier

REQ-10.04.02-TS-0002.0270

Requirement

The CWP shall display non-conformance warnings to the controller when
deviations are detected.

Title Display of the non-conformance warnings due to deviations

Status <Validated >

Rationale All detected deviations has to be available to be displayed, that does not
necessarily mean that all detected deviations have to be displayed (they
may be configured, adapted, or manually inhibited). Related to REQ-
10.04.02-TS-0001.0180.
The requirement has been validated in EXE-04.07.02-VP-741.

Category <HMI>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED TO>
<ALLOCATED TO>
<APPLIES TO>
<APPLIES_TO>

[REQ]

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-04.07.02-SPR-CDR1.1190 <Full>
<ATMS Requirement> REQ-05.07.02-SPR-CDR2.1030 <Full>
<ATMS Requirement> REQ-05.07.02-INTEROP-0030.0002 <Full>
<Enabler> ER ATC 91 <Full>
<Enabler> ER_ATC_157 <Full>
<Functional block> Controller HMI Management N/A
<Project> 10.04.02 N/A
<Operational Focus Area> OFA03.03.01 N/A
<Operational Focus Area> OFA03.03.02 N/A

Identifier

REQ-10.04.02-TS-0002.0280

Requirement

The CWP shall display the type of deviation detected for a non-conformance
warning.

Title Display of the type of deviation in a hon-conformance warning

Status <Validated >

Rationale The precise non-conformance warnings to be defined and the related HMI
customizations are implementation dependent. Related to REQ-10.04.02-
TS-0001.0190.
The requirement has been validated in EXE-04.07.02-VP-741.
<HMI>

Category
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Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1190 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1030 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0002 <Full>
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.03.02 N/A

[REQ]

Identifier REQ-10.04.02-TS-0002.0290

Requirement The CWP shall display a conformance monitoring warning until it is removed

by the Conformance Monitoring Function.

Title Display and remove the monitoring warning.
Status <Validated >
Rationale The non-conformance warning to be distributed, displayed and removed to

the interested position sectors. Related to REQ-10.04.02-TS-0001.0230.
The requirement has been validated in EXE-04.07.02-VP-741.

Category <HMI>
Validation Method <Live Trial>

<Real Time Simulation>
Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1030 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0002 <Full>
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.02 N/A

[REQ]

Identifier REQ-10.04.02-TS-0002.0310

Requirement The CWP shall display non-conformance warnings to the controller when
deviations are detected by the TC-Aid.

Title Display of a warning if the TC-Aid detects deviations

Status <In Progress>

Rationale Warnings regarding deviations detected by the TC-Aid help to increase
Controller awareness.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <HMI>

Validation Method <Live Trial>
<Real Time Simulation>

Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
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<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1190 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1030 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0002 <Full>
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<ALLOCATED _TO> <Functional block> Controller HMI Management N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.03.02 N/A

[REQ]

Identifier REQ-10.04.02-TS-0002.0320

Requirement The CWP shall remove the display of the warning to the controller if a

deviation detected by the TC-Aid no longer exists

Title Removal of the warning in case of a deviation no longer exists
Status <In Progress>
Rationale In order not to disturb the Controller with already not-existing deviations,

warnings notifying them should be removed from the CWP.
Implementation not requested in any validation exercise supported by

P10.04.02
Category <HMI>
Validation Method <Live Trial>

<Real Time Simulation>
Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-04.07.02-SPR-CDR1.1210 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1030 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0002 <Full>
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<ALLOCATED_TO> <Functional block> Controller HMI Management N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.03.02 N/A

[REQ]

Identifier REQ-10.04.02-TS-0002.0350

Requirement The CWP shall display the following deviations between actual track data
and controller clearance data:

a) Route deviation (ROUTE);

b) Vertical rate deviation (RATE);

c) Cleared flight level deviation (CFL);

d) No valid Flight Plan data

Title Display deviations between actual track and controller clearance.
Status <Validated >
Rationale The controller should be aware of the deviations above described detected

between the radar track and its clearances.
The requirement has been validated in EXE-04.07.02-VP-741.

Category <HMI>
Validation Method <Live Trial>

<Real Time Simulation>
Verification Method <Test>

[REQ Trace]

Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-05.07.02-SPR-CDR2.1150 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-INTEROP-0030.0003 <Partial>
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<SATISFIES>
<SATISFIES>
<ALLOCATED_TO>
<ALLOCATED TO>
<APPLIES TO>
<APPLIES_TO>

[REQ]

<Enabler>

<Enabler>

<Functional block>
<Project>

<Operational Focus Area>
<Operational Focus Area>

ER ATC 91

ER ATC 157

Controller HMI Management
10.04.02

OFA03.03.01

OFA03.03.02

<Full>
<Full>
N/A
N/A
N/A
N/A

Identifier

REQ-10.04.02-TS-0002.0360

Requirement

The CWP shall display deviation warnings for aircraft depending on sector
frequency status and actual position.

Title Display of deviation warnings based on frequency and actual position

Status <In Progress>

Rationale Controller has to be informed with warnings about the deviations that occur
if the flight is under control of the ATSU and the position of the flight to avoid
overlapping with other sectors CWPs.
Implementation not requested in any validation exercise supported by
P10.04.02

Category <HMI>

Validation Method <Live Trial>

<Real Time Simulation>

Verification Method

<Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED TO>
<ALLOCATED_TO>
<APPLIES TO>
<APPLIES TO>

[REQ]

Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-04.07.02-OSED-0001.3019 <Full>
<ATMS Requirement> REQ-05.07.02-SPR-CDR2.1040 <Full>
<ATMS Requirement> REQ-05.07.02-SPR-CDR2.1090 <Partial >
<Enabler> ER_ATC 91 <Full>
<Enabler> ER ATC 157 <Full>
<Functional block> Controller HMI Management N/A
<Project> 10.04.02 N/A
<Operational Focus Area> OFA03.03.01 N/A
<Operational Focus Area> OFA03.03.02 N/A

Identifier

REQ-10.04.02-TS-0002.0370

Requirement

The CWP shall display a warning to the controller when any deviation from
coordination conditions detected by the PC-Aid

Title Display of a warning when PC-Aid detects deviations from coordination.
Status <Validated >
Rationale Controller should be alerted when deviations found by the PC-Aid in the
coordination conditions,
The requirement has been validated in EXE-04.07.02-VP-741.
Category <HMI>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>

[REQ Trace]
Relationship
<SATISFIES>
<SATISFIES>
<SATISFIES>
<SATISFIES>
<ALLOCATED TO>
<ALLOCATED_TO>
<APPLIES TO>
<APPLIES TO>

“ £ Avenue de Cortenbergh 100 | B -1000 Bruxelles
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Linked Element Type Identifier Compliance
<ATMS Requirement> REQ-04.07.02-SPR-CDR2.1240 <Full>
<ATMS Requirement> REQ-04.07.02-SPR-CDR2.1250 <Full>
<Enabler> ER ATC 91 <Full>
<Enabler> ER ATC 157 <Full>
<Functional block> Controller HMI Management N/A
<Project> 10.04.02 N/A
<Operational Focus Area> OFA03.03.01 N/A
<Operational Focus Area> OFA03.03.02 N/A
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[REQ]
Identifier REQ-10.04.02-TS-0002.0380
Requirement The CWP shall display a warning after reception of Mode S DAP if a
deviation is detected between controller clearance and Mode S DAP.
Title Display of a warning if deviations between clearance and received Mode S
DAP
Status <Validated >
Rationale Controller should be aware of the incongruence between different sources
of information, including the clearances and the Mode S DAP.
The requirement has been validated in EXE-04.07.02-VP-741.
Category <HMI>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> ER ATC 91 <Full>
<SATISFIES> <Enabler> ER_ATC_157 <Full>
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3026 <Full>
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.02 N/A
[REQ]
Identifier REQ-10.04.02-TS-0002.0390
Requirement The CWP shall display warning after a new controller clearance if a
deviation is detected between controller clearance and Mode S DAP.
Title Display of a warning if deviations between new clearance and Mode S DAP
Status <Validated >
Rationale Controller should be aware of the incongruence between different sources
of information, including the clearances and the Mode S DAP.
The requirement has been validated in EXE-04.07.02-VP-741.
Category <HMI>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <ATMS Requirement> REQ-04.07.02-OSED-0001.3026 <Full>
<SATISFIES> <Enabler> ER_ATC_91 <Full>
<SATISFIES> <Enabler> ER ATC 157 <Full>
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<ALLOCATED_TO> <Project> 10.04.02 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.02 N/A
[REQ]
Identifier REQ-10.04.02-TS-0003.0480
Requirement The CWP shall display a deviation between cleared IAS and detected IAS.
Title Display of a warning if deviations between cleared IAS and detected IAS
Status <In Progress>
Rationale Actual IAS will be provided by aircraft via ADS. Related to REQ-10.04.02-
TS-0001.0430
Implementation not requested in any validation exercise supported by
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P10.04.02
Category <HMI>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO0.2022 <Partial>
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]
Identifier REQ-10.04.02-TS-0003.0490
Requirement The CWP shall display warning indicating minutes and Flight ID when there
is a deviation between the future positions and the reference trajectory
Title Display of a warning if deviations between the future positions and the
reference trajectory
Status <In Progress>
Rationale It is expected that the conformance monitoring tool does not just compare

present position against reference trajectory, but also future positions
Related to REQ-10.04.02-TS-0001.0460
Implementation not requested in any validation exercise supported by

P10.04.02
Category <HMI>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP ATC 94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2025 <Partial>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2021 <Full>
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.01 N/A
<APPLIES_TO> <Operational Focus Area> OFA03.03.02 N/A
<CHANGED BECAUSE OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
[REQ]
Identifier REQ-10.04.02-TS-0003.0500
Requirement The CWP shall display a warning when a CTA vs RTA deviation is detected
Title Display of CTA vs RTA deviation warning
Status <In Progress>
Rationale The non-conformance warning is to be distributed, displayed and removed
to the interested position sector. Related to REQ-10.04.02-TS-0003.0240
Implementation not requested in any validation exercise supported by
P10.04.02
Category <HMI>
Validation Method <Live Trial>
<Real Time Simulation>
Verification Method <Test>
[REQ Trace]
Relationship Linked Element Type Identifier Compliance
<SATISFIES> <Enabler> APP_ATC_94 <Full>
<SATISFIES> <ATMS Requirement> REQ-05.07.02-OSED-MCMO.2019 <Partial>
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Project ID 10.04.02

D44 - Consolidated Conformance Monitoring System Requirements Edition: 00.04.00
<ALLOCATED TO> <Functional block> Controller HMI Management N/A
<APPLIES TO> <Operational Focus Area> OFA03.03.02 N/A
<CHANGED_BECAUSE_OF> <Change Order> Change reference N/A
<ALLOCATED TO> <Project> 10.04.02 N/A
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gss  Appendix A Traceability of TS requirements with
889 P04.07.02 OSED/SPR and P05.07.02 OSED/SPR/INTEROP
890 The following table depicts the traceability of TS requirements with P04.07.02 OSED (D28),
891 P04.07.02 SPR (D23) and P05.07.02 OSED/SPR/INTEROP (D77,D78, D79). See References section
892  for references details.
TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
o REQ-04.07.02- o
REQ- Eligibility for | MONA OSED-0001.2005 Monitor input data
10.04.02- conformance
TS- monitoring Continuous monitoring
REQ-04.07.02-
et SPR-CDR1.1200
REQ-05.07.02- CMON - Reference
OSED-MCMO.2003 | trajectory
REQ-05.07.02- CMON - last
OSED-MCMO.2004 | clearance is part of
reference trajectory
CMON - direct to IAF
REQ-05.07.02- - MSA
OSED-MCMO0.2010
CMON - ADS-B/C
REQ-05.07.02- data
OSED-MCMO0.2002
CMON - SID below
REQ-05.07.02- 120 m above DER -
REQ-05.07.02- Tactical Trajectory
SPR-CDR2.1020 Deviation detects
deviations
Eligible FPs for CMON
tool
REQ-05.07.02-
INTEROP-
0030.0001 MONA in Free Routing
Airspace
Trajectory adherence
monitoring in FRA
- £> Avenue de Cortenbergh 100 | B -1000 Bruxelles
Rt - www.sesarju.eu
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Project ID 10.04.02
D44 - Consolidated Conformance Monitoring System Requirements

Edition: 00.04.00

REQ-04.07.02-
OSED-FR04.0250

REQ-04.07.02-
SPR-FRTA.0101

REQ-04.07.02-
SPR-FR00.0312

REQ-04.07.02-
SPR-FRTA.1002

REQ-04.07.02-
SPR-DR00.0310

REQ- Continuous REQ-04.07.02-
10.04.02- monitoring of OSED-0001.2005
TS- track data and

0001.0022 clearance data REQ-04.07.02-

SPR-CDR1.1200

REQ-05.07.02-
OSED-MCMO.2001

REQ-05.07.02-
OSED-MCMO.2003
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REQ-05.07.02-
OSED-MCMO.2004

REQ-05.07.02-
OSED-MCMO.2002

REQ-05.07.02-
SPR-CDR2.1020

REQ-04.07.02-
OSED-FR04.0250

REQ-04.07.02-
SPR-FRTA.0101

REQ-04.07.02-
SPR-FRTA.1002

REQ- Conformance REQ-04.07.02-

10.04.02- monitoring OSED-0001.4037

TS- discarding due to

0001.0023 | NoTT  deviation REQ-04.07.02-
detection OSED-0001.2004

REQ-

REQ-05.07.02-

Vertical deviation
10.04.02- OSED-MCMO0.2010

Ts. when AFL is lower
0001.0024 than tr_me vertical
constraint
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TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
'1:%5 OQ‘; 02- Conformance MONA REQ-05.07.02- CMON - SID below
TS‘_ ) Monitoring at or OSED-MCMO.2011 | 120 m_aboye DER -
0001.0026 below 120 meters no notification
) above DER
I1:{(|JE OQ‘; 02- Conformance MONA REQ-05.07.02- CMON-SID 120 m
TS‘_ ) Monitoring OSED-MCMO0.2012 | above DER below
0001.0027 warnings MSA . at
’ according to a
dedicated vertical CMON-SID 120 m
tolerance REQ-05.07.02- above DER below
OSED-MCMO0.2013 | MSA . at or above
CMON-SID 120 m
above DER below
REQ-05.07.02- MSA . at or below
OSED-MCMO0.2014
CMON - SID above
MSA . at
CMON - SID above
MSA . at or above
REQ-05.07.02-
OSED-MCMO0.2015 | CMON - SID above
MSA . at or above
REQ-05.07.02-
OSED-MCMO0.2016
REQ-05.07.02-
OSED-MCMO0.2017
e 02, | Route Deviation | MONA REQ-04.07.02- Detection of a route
TS. Detection for a OSED-0001.3020 deviation
0001.0030 | flight plan
REQ-04.07.02- Continuous monitoring
SPR-CDR1.1200
CMON - Lateral
REQ-05.07.02- deviation notification
OSED-MCMO.2005
Conditions for a lateral
Deviation
REQ-04.07.02-
OSED-0001.2004
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Edition: 00.04.00

REQ-04.07.02-
OSED-FR04.0250

REQ-04.07.02-
SPR-FRTA.0101

REQ-04.07.02-
SPR-FR00.0312

REQ-04.07.02-
SPR-DR00.0310

REQ-04.07.02-
SPR-CDR1.1210

REQ- Removal of lateral
10.04.02- deviation warning
TS- after new route
0001.0050 | assigned from the
controller

REQ-05.07.02-
OSED-MCMO.2005

REQ-04.07.02-
OSED-FR04.0250

REQ-04.07.02-
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SPR-FRTA.0101

Route Deviation
10.04.02- Removal
TS-
0001.0051

REQ-04.07.02-
SPR-CDR1.1210

REQ-05.07.02-
OSED-MCMO.2005

REQ-04.07.02-
OSED-0001.2004

REQ-04.07.02-
OSED-FR04.0250

REQ-04.07.02-
SPR-FRTA.0101

REQ-04.07.02-
SPR-FR00.0312

REQ-04.07.02-
SPR-FRTA.1002
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TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
REQ-04.07.02-
SPR-DR00.0310
00002 | comaormammn | TONMA | REQ-05.07.02- | CMON ateral 2
TS‘_ ) OSED-MCMO.2018 | sigma
GUOT0450 REQ-05.07.02- CMON - Lateral
OSED-MCMO.2024 | tolerance considering
PBN
e 0. | porteal Rate MONA REQ-04.07.02- Detection of a cleared
TsS. Detection OSED-0001.3021 rate deviation
. REQ-05.07.02- CMON - vertical
OSED-MCMO.2006 | deviation notification
Conditions for a
vertical Deviation
REQ-04.07.02-
OSED-0001.3126
REQ- Vertical Rate MONA Remove deviation tag
10.04.02- Deviation removal 253:8%32222'1 0
TS- due to flight. ) CMON - vertical
0001.0142 REQ-05.07.02- deviation notification
OSED-MCMO.2006 Conditions for a
vertical Deviation
REQ-04.07.02-
OSED-0001.3126
REQ- CFL Deviation MONA Detection of a CFL
10.04.02- | Detection for CFL gggg"c‘)gg 1'03?622 deviation
TS- Reached ) .
0001.0151 CMON - vertical
REQ-05.07.02- R - -
OSED-MCMO 2006 deviation notification
Conditions for a
REQ-04.07.02- - o
OSED-0001 3126 vertical Deviation
REQ- CFL Deviation MONA Detection of a CFL
10.04.02- | Detection for CFL R 0z | deviation
TS- Not Reached B :
0001.0152 CMON - vertical
REQ-05.07.02- . . .
OSED-MCMO 2006 deviation notification
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TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
Conditions for a
REQ-04.07.02- . L
OSED-0001.3126 vertical Deviation
REQ- CFL Deviation MONA REQ-04.07.02- Remove deviation tag
10.04.02- removal due to SPR-CDR1.1210
TS- flight return to - : CMON - vertical
0001.0153 cleared level. REQ-05.07.02- deviation notification
OSED-MCMO.2006 Conditions for a
vertical Deviation
REQ-04.07.02-
OSED-0001.3126
REQ- Mode S Selected | MONA REQ-04.07.02- Adherence of downlink
10.04.02- Altitude Deviation OSED-0001.3026 parameters to
TS- Detection with clearances
0001.0161 clearance latency
Mode S parameters
REQ-04.07.02-
SPR-CDR1.1220
REQ- Mode S Selected | MONA REQ-04.07.02- Adherence of downlink
10.04.02- Altitude Deviation OSED-0001.3026 parameters to
TS- removal clearances
0001.0163
Remove deviation tag
REQ-04.07.02-
SPR-CDR1.1210
REQ- Mode S Selected | MONA REQ-04.07.02- Adherence of downlink
10.04.02- Altitude Deviation OSED-0001.3026 parameters to
TS- Detection with clearances
0001.0165 pilot latency.
Mode S parameters
REQ-04.07.02-
SPR-CDR1.1220
REQ- Level Bust MONA REQ-04.07.02- Detection of a Level
10.04.02- Deviation OSED-0001.3023 Bust
TS- Detection CMON - vertical
REQ-05.07.02- b - .
0001.0181 OSED-MCMO 2006 deviation notification
Conditions for a
REQ-04.07.02- . o
OSED-0001.3126 vertical Deviation
REQ- Level Bust MONA REQ-04.07.02- Remove deviation tag
10.04.02- Deviation removal SPR-CDR1.1210
TS- due to vertical CMON - vertical
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TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
0001.0182 rate correction. deviation notification
Conditions for a

REQ-05.07.02- : - ie

OSED-MCMO 2006 vertical Deviation

REQ-04.07.02-

OSED-0001.3126

REQ- NoTT Deviation MONA REQ-04.07.02- Detection of

10.04.02- Detection OSED-0001.3024 unavailability of a

TS- Flight Plan

0001.0191
REQ-04.07.02- Conditions for a lateral
OSED-0001.2004 Deviation

REQ- NoTT Deviation MONA REQ-04.07.02- Remove deviation tag

10.04.02- removal SPR-CDR1.1210

TS-

0001.0194

REQ- Coordination MONA REQ-04.07.02- Detection of deviations

10.04.02- conditions failure OSED-0002.4017 from entry/exit

TS- warning conditions

0001.0170

REQ-04.07.02- Monitoring of

OSED-0002.3053 deviations wrt the
entry/exit conditions
Deviating from the
flight level constraint

REQ-04.07.02-

SPR-CDR2.1240 Monitoring of
achievable entry/exit
conditions

REQ-04.07.02-

OSED-0002.2014

REQ- Entry/Exit MONA/HMI | REQ-04.07.02- Detection of deviations
10.04.02- coordination OSED-0002.4017 from entry/exit

TS- failure conditions

0001.0175

REQ-04.07.02- Monitoring of

OSED-0002.3053 deviations wrt the
entry/exit conditions

REQ-04.07.02- Deviating from the

SPR-CDR2.1240 flight level constraint
Spurious alerts

REQ-04.07.02-

SPR-CDR2.1250 Monitoring of

lounding mambers

- 9 Avenue de Cortenbergh 100 | B -1000 Bruxelles

| v www.sesarju.eu 76 of 97
©SESAR JOINT UNDERTAKING, 2015. Created by LEONARDO, INDRA, THALES, BELGOCONTROL/DSNA, NATMIG for
the SESAR Joint Undertaking within the frame of the SESAR Programme co-financed by the EU and EUROCONTROL. Reprint
with approval of publisher and the source properly acknowledged



TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
achievable entry/exit
conditions
REQ-04.07.02-
OSED-0002.2014
REQ- STAR constraint MONA REQ-05.07.02- CMON - STAR
10.04.02- at or above OSED-MCMO.2007 | constraint at or above
TS-
0001.0400 REQ-05.07.02- CMON - STAR
OSED-MCMO.2008 | constraint at
REQ-05.07.02- CMON - STAR
OSED-MCMO.2009 | constraint at or below
REQ- CTAvs RTA MONA REQ-05.07.02- CMON - CTA vs RTA
10.04.02- deviation OSED-MCMO.2019 | deviation
TS-
0001.0410 REQ-05.07.02- CMON - time
OSED-MCMO0.2020 | tolerance
REQ-04.07.02- Warning on false CTO
OSED-0003.2031 implementation
REQ- Actual IAS vs MONA REQ-05.07.02- CMON - Actual IAS vs
10.04.02- Cleared IAS OSED-MCMO0.2022 | Cleared IAS deviation
TS- deviation
0001.0430
REQ- Aircraft Derived MONA REQ-05.07.02- CMON - Aircraft
10.04.02- Data or EPP OSED-MCMO0.2025 | Derived Data or EPP
TS- usage usage
0001.0460 REQ-05.07.02-
OSED-MCMO0.2021 | CMON — ATA vs ETA
deviation
REQ- Conformance MONA REQ-05.07.02- Minimum flight plans
10.04.02- monitoring SPR-CDR1.3020
TS- capacity
0001.0470
REQ- Processing of MONA REQ-04.07.02- Monitor input data
10.04.02- track information OSED-0001.2005
TS-
0001.0320 REQ-05.07.02- CMON - Radar data
OSED-MCMO.2001 | primary source
REQ-05.07.02- Eligible FPs for CMON
INTEROP- tool
0030.0001
Interoperability of
REQ-05.07.02- Conformance
INTEROP- Monitoring with
0030.0006 Surveillance data
Interoperability of
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REQ-05.07.02-
INTEROP-
0030.0007

REQ- Data items from a [ REQ-04.07.02-

10.04.02- non-conformance SPR-CDR1.1190
TS- warning
0001.0330 REQ-05.07.02-

SPR-CDR2.1150

REQ-05.07.02-
INTEROP-
0030.0002

REQ-05.07.02-
INTEROP-
0030.0003
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Conditions for REQ-04.07.02-
Deviation OSED-0001.2004
Trajectory
0001.0340 | calculation trigger

REQ-04.07.02-
OSED-0001.3010

REQ-04.07.02-
OSED-0001.3011

REQ-04.07.02-
SPR-CDR1.1120

REQ-04.07.02-
SPR-CDR1.1130

REQ-04.07.02-
SPR-CDR1.1140

REQ-04.07.02-
SPR-CDR1.1150

REQ-04.07.02-
SPR-CDR1.1160

REQ-04.07.02-
SPR-CDR1.1170

REQ-05.07.02-
SPR-CDR2.1150

REQ-05.07.02-
SPR-CDR2.1160
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TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
REQ-05.07.02-
INTEROP-
0030.0003
REQ- Tactical Trajectory | MONA REQ-04.07.02- Conditions to predict
10.04.02- Calculation OSED-0001.3093 the lateral trajectory
TS- Trigger due to
0001.0341 absence of
deviation Tactical and deviation
REQ-04.07.02- trajectories
SPR-CDR1.1180
Alternative Trajectory
Assessment info from
Trajectory Deviation
REQ-05.07.02-
SPR-CDR2.1160
REQ- Threshold inputs. | MONA REQ-04.07.02- Detection of a route
10.04.02- OSED-0001.3020 deviation
TS-
0001.0350 REQ-04.07.02- Detection of a cleared
OSED-0001.3021 rate deviation
REQ- Processing of MONA REQ-04.07.02- Monitor input data
10.04.02- planned trajectory OSED-0001.2005
TS- and controller
0001.0310 | clearances data REQ-04.07.02- Continuous monitoring
SPR-CDR1.1200
REQ-05.07.02-
SPR-CDR2.1140 CMON - last
clearance is part of
REQ-05.07.02- reference trajectory
OSED-MCMO.2004
CMON - Path
REQ-05.07.02- terminators
OSED-MCMO0.2023 | compatibility
Tactical Trajectory
REQ-05.07.02- Deviation updated with
SPR-CDR2.1140 new trajectory
Eligible FPs for CMON
REQ-05.07.02- tool
INTEROP-
0030.0001
Interoperability
REQ-05.07.02- between Conformance
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m

TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
INTEROP- Monitoring & the
0030.0004 Trajectory Prediction
Service (Trajectory
Data)
Interoperability of
Conformance
REQ-05.07.02- Monitoring with Flight
INTEROP- Data
0030.0005
REQ- Acknowledgement | MONA/HMI | REQ-05.07.02- Interoperability of
10.04.02- inputs. INTEROP- Conformance
TS- 0030.0005 Monitoring with Flight
0001.0360 Data
REQ- Displaying MONA/HMI | REQ-04.07.02- Conditions for
10.04.02- availability of non- OSED-0001.3019 displaying a deviation
TS- conformance warning
0001.0180 | warnings.
REQ-04.07.02- HMI alert
SPR-CDR1.1190
REQ-05.07.02- CMON - Lateral
OSED-MCMO.2005 | deviation notification
REQ-05.07.02- CMON - vertical
OSED-MCMO.2006 | deviation notification
REQ- Availability of type | MONA/HMI | REQ-04.07.02- Conditions for
10.04.02- of trajectory OSED-0001.3019 displaying a deviation
TS- deviation for non- warning
0001.0190 conformance
warning. REQ-04.07.02- HMI alert
SPR-CDR1.1190
REQ- Presentation and | MONA/HMI | REQ-04.07.02- Conditions for
10.04.02- removal of OSED-0001.3019 displaying a deviation
TS- conformance warning
0001.0230 | warning
REQ-04.07.02- Remove deviation tag
SPR-CDR1.1210
CMON - Lateral
REQ-05.07.02- deviation notification
OSED-MCMO.2005
CMON - vertical
REQ-05.07.02- deviation notification
OSED-MCMO.2006
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TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
REQ- Presentation of MONA REQ-05.07.02- CMON - CTA vs RTA
10.04.02- CTAvs RTA OSED-MCMO.2019 | deviation
TS- deviation
0003.0240 REQ-04.07.02- Warning on false CTO
OSED-0003.2031 implementation
REQ- Acceptability of MONA REQ-04.07.02- Loss of TC Aid
10.04.02- Loss of TC-Aid SPR-CDR1.2030
TS-
0002.0100
REQ- Acceptability of MONA REQ-04.07.02- Delay of TC Aid
10.04.02- Delay of TC-Aid SPR-CDR1.2070
TS-
0002.0200
REQ- Acceptability of MONA REQ-04.07.02- Corruption of TC Aid
10.04.02- Corruption SPR-CDR1.2110
TS- (Undetected) of
0002.0300 | TC-Aid
REQ- Acceptability of MONA REQ-04.07.02- Corruption of TC Aid
10.04.02- Corruption SPR-CDR1.2140
TS- (Detected) of TC-
0002.0400 | Aid
REQ- Controller MONA/HMI | REQ-04.07.02- Remove deviation tag
10.04.02- removing the SPR-CDR1.1210
TS- lateral deviation Tactical Trajectory
0002.0240 | warning when REQ-05.07.02- Deviation updated with
(10.10.02 assessed. SPR-CDR2.1140 new trajectory
contribution)
Tactical Trajectory
Deviation provides
details about deviation
Interoperability of
REQ-05.07.02- Conformance
SPR-CDR2.1150 Monitoring with Flight
Data
REQ-05.07.02-
INTEROP-
0030.0005
REQ- Display of an MONA/HMI | REQ-04.07.02- Detection of deviations
10.04.02- Entry/Exit OSED-0002.4017 from entry/exit
TS- coordination conditions
0002.0250 | failure
(10.10.02 Monitoring of
contribution) deviations wrt the
REQ-04.07.02- entry/exit conditions
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m

TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
OSED-0002.3053
Deviating from the
flight level constraint
Spurious alerts
REQ-04.07.02-
SPR-CDR2.1240 Tactical Trajectory
Deviation provides
details about deviation
REQ-04.07.02- Monitoring of
SPR-CDR2.1250 achievable entry/exit
conditions
REQ-05.07.02-
SPR-CDR2.1150
REQ-04.07.02-
OSED-0002.2014
REQ- Controller MONA/HMI | REQ-05.07.02- Interoperability of
10.04.02- acknowledge to INTEROP- Conformance
TS- deviations 0030.0005 Monitoring with Flight
0002.0260 Data
(10.10.02
contribution)
REQ- Display of the MONA/HMI | REQ-04.07.02- Conditions for
10.04.02- non-conformance OSED-0001.3019 displaying a deviation
TS- warnings due to warning
0002.0270 deviations
(10.10.02
contribution) REQ-04.07.02- HMI alert
SPR-CDR1.1190
REQ-05.07.02- Tactical Trajectory
SPR-CDR2.1030 Deviation shows
deviation alerts
Interoperability
between Conformance
REQ-05.07.02- Monitoring & the
INTEROP- Controller.
0030.0002
REQ- Display of the MONA/HMI | REQ-04.07.02- Conditions for
10.04.02- type of deviation OSED-0001.3019 displaying a deviation
TS- in a non- warning
0002.0280 conformance
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TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
(10.10.02 warning HMI alert
contribution) REQ-04.07.02-
SPR-CDR1.1190
Tactical Trajectory
REQ-05.07.02- Deviation shows
SPR-CDR2.1030 deviation alerts
Interoperability
between Conformance
Monitoring & the
REQ-05.07.02- Controller.
INTEROP-
0030.0002
REQ- Display and MONA/HMI | REQ-04.07.02- Conditions for
10.04.02- remove the OSED-0001.3019 displaying a deviation
TS- monitoring warning
0002.0290 | warning.
(10.10.02 REQ-04.07.02- Remove deviation tag
contribution) SPR-CDR1.1210
Tactical Trajectory
REQ-05.07.02- Deviation shows
SPR-CDR2.1030 deviation alerts
Interoperability
REQ-05.07.02- between Conformance
INTEROP- Monitoring & the
0030.0002 Controller.
REQ- Display of a MONA/HMI | REQ-04.07.02- HMI alert
10.04.02- warning if the TC- SPR-CDR1.1190
TS- Aid detects
0002.0310 deviations REQ-05.07.02- Tactical Trajectory
(10.10.02 SPR-CDR2.1030 Deviation shows
contribution) deviation alerts
Interoperability
between Conformance
REQ-05.07.02- Monitoring & the
INTEROP- Controller.
0030.0002
REQ- Removal of the MONA/HMI | REQ-04.07.02- Remove deviation tag
10.04.02- warning in case of SPR-CDR1.1210
TS- a deviation no Tactical Trajectory
0002.0320 longer exists Deviation shows
(10.10.02 REQ-05.07.02- deviation alerts
contribution) SPR-CDR2.1030
Interoperability
between Conformance
Monitoring & the
Controller.
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TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
REQ-05.07.02-
INTEROP-
0030.0002
REQ- Display deviations | MONA/HMI | REQ-05.07.02- Interoperability
10.04.02- between actual INTEROP- between Conformance
TS- track and 0030.0003 Monitoring & the
0002.0350 controller Trajectory Prediction
(10.10.02 clearance. Service (Deviation
contribution) Trajectory Request)
REQ- Display of MONA/HMI | REQ-04.07.02- Conditions for
10.04.02- deviation OSED-0001.3019 displaying a deviation
TS- warnings based warning
0002.0360 on frequency and
(10.10.02 actual position REQ-05.07.02- Tactical Trajectory
contribution) SPR-CDR2.1040 Deviation Detection
notifies only certain
deviations
REQ-05.07.02- Tactical Trajectory
SPR-CDR2.1090 Deviation reflects
sectors
REQ- Display of a MONA/HMI | REQ-04.07.02- Detection of deviations
10.04.02- warning when PC- OSED-0002.4017 from entry/exit
TS- Aid detects conditions
0002.0370 deviations from REQ-04.07.02- Deviating from the
(10.10.02 coordination. SPR-CDR2.1240 flight level constraint
contribution)
REQ-04.07.02- Spurious alerts
SPR-CDR2.1250
REQ- Display of a MONA/HMI | REQ-04.07.02- Adherence of downlink
10.04.02- warning if OSED-0001.3026 parameters to
TS- deviations clearances
0002.0380 between
(10.10.02 clearance and
contribution) | received Mode S
DAP
REQ- Display of a MONA/HMI | REQ-04.07.02- Adherence of downlink
10.04.02- warning if OSED-0001.3026 parameters to
TS- deviations clearances
0002.0390 between new
(10.10.02 clearance and
contribution) | Mode S DAP
REQ- Display of a MONA/HMI | REQ-05.07.02- CMON - Actual IAS vs
10.04.02- warning if OSED-MCMO0.2022 | Cleared IAS deviation
TS- deviations
0003.0480 between cleared
(10.10.02 IAS and detected
contribution) | IAS
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Proj

D_‘]:]_ Z SO c

d Conformance Monitoring System Requirements Edition: 00.
TS Requirement Related requirement
Identifier Title Subsystem | Identifier Title
element
that the
requirement
is allocated
to
REQ- Display of a MONA/HMI | REQ-05.07.02- CMON - Aircraft
10.04.02- warning if OSED-MCMO.2025 | Derived Data or EPP
TS- deviations usage
0003.0490 | between the REQ-05.07.02-
(10.10.02 future positions OSED-MCMO0.2021 | CMON — ATA vs ETA
contribution) | and the reference deviation
trajectory
REQ- Display of CTAvs | MONA/HMI | REQ-05.07.02- CMON - CTA vs RTA
10.04.02- RTA deviation OSED-MCMO.2019 | deviation
TS- warning
0003.0500
(10.10.02
contribution)
REQ- Frequency of MONA REQ-05.07.02- Detected corruption of
10.04.02- detected SPR-CDR1.2030 the new trajectory
TS- corruption of input
0002.0500 | data Corrupted data in the
deviation trajectory
REQ-05.07.02- function
SPR-CDR1.2080
REQ- Frequency of MONA REQ-05.07.02- Detected corruption of
10.04.02- undetected SPR-CDR1.2030 the new trajectory
TS- corruption of input
0002.0600 data Corrupted data in the
deviation trajectory
REQ-05.07.02- function
SPR-CDR1.2080
893 Table 4: TS requirements traceability
894
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Project ID 10.04.02

D44 - Consolidated Conformance Monitoring System Requirements

Edition: 00.04.00

g5  Appendix B Subset of TS requirements linked to HMI
896 functional block
897  The following table depicts a subset of TS requirements linked to HMI functional block.

Identifier Title TS requirements written
in close collaboration
with P10.10.02 project

REQ-10.04.02-TS-0001.0175 | Entry/Exit coordination failure No

REQ-10.04.02-TS-0001.0360 | Acknowledgement inputs. No

REQ-10.04.02-TS-0001.0180 | Displaying availability of non-conformance No

warnings.

REQ-10.04.02-TS-0001.0190 | Availability of type of trajectory deviation for | No

non-conformance warning.

REQ-10.04.02-TS-0001.0230 | Presentation and removal of conformance No

warning

REQ-10.04.02-TS-0002.0240 | Controller removing the lateral deviation Yes

warning when assessed.

REQ-10.04.02-TS-0002.0250 | Display of an Entry/Exit coordination failure |Yes

REQ-10.04.02-TS-0002.0260 | Controller acknowledge to deviations Yes

REQ-10.04.02-TS-0002.0270 | Display of the non-conformance warnings Yes

due to deviations

REQ-10.04.02-TS-0002.0280 | Display of the type of deviation in a non- Yes

conformance warning

REQ-10.04.02-TS-0002.0290 | Display and remove the monitoring warning. | Yes

REQ-10.04.02-TS-0002.0310 | Display of a warning if the TC-Aid detects Yes

deviations

REQ-10.04.02-TS-0002.0320 | Removal of the warning in case of a Yes

deviation no longer exists

REQ-10.04.02-TS-0002.0350 | Display deviations between actual track and | Yes

controller clearance.

lounding meambers
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Project ID 10.04.02
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Identifier Title TS requirements written
in close collaboration
with P10.10.02 project

REQ-10.04.02-TS-0002.0360 | Display of deviation warnings based on Yes

frequency and actual position

REQ-10.04.02-TS-0002.0370 | Display of a warning when PC-Aid detects Yes
deviations from coordination

REQ-10.04.02-TS-0002.0380 | Display of a warning if deviations between Yes
clearance and received Mode S DAP

REQ-10.04.02-TS-0002.0390 | Display of a warning if deviations between Yes
new clearance and Mode S DAP

REQ-10.04.02-TS-0003.0480 | Display of a warning if deviations between Yes
cleared IAS and detected IAS

REQ-10.04.02-TS-0003.0490 | Display of a warning if deviations between Yes
the future positions and the reference
trajectory

REQ-10.04.02-TS-0003.0500 | Display of CTA vs RTA deviation warning Yes

898 Table 5: Subset of TS requirements linked to HMI functional block
899

lounding meambers
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Appendix C Subset of 04.07.02 OSED and SPR allocated
to Functional Block MONA by P10.01.07

Subset of P04.07.02 OSED (D28) and SPR (D23) allocated to Functional Block MONA by P10.01.07

on D120 [6].
OSED OSED OSED OSED Requirement Text Functional
Deliverable Requirement | Requirement Block
Identifier Title
04.07.02-OSED- | REQ-04.07.02- | Monitor input | The "TC aid" shall continuously monitor MONA
D19-02.00.00- OSED- data actual track data and controller clearance
REQ 0001.2005 data.
04.07.02-OSED- | REQ-04.07.02- | Conditions for | The deviation warnings shall be displayed MONA
D19-02.00.00- OSED- displaying a for aircraft depending on sector frequency
REQ 0001.3019 deviation status and actual position.
warning
04.07.02-OSED- | REQ-04.07.02- | Detection of a | The "TC aid" shall detect route deviations MONA
D19-02.00.00- OSED- route deviation | a) if the actual track position differs from the
REQ 0001.3020 cleared flight path by more than a
parameter, or
b) if the actual track position is outside a
radius around a waypoint.
04.07.02-OSED- | REQ-04.07.02- | Detection of a | The "TC-aid" shall detect vertical rate MONA
D19-02.00.00- OSED- cleared rate deviations if
REQ 0001.3021 deviation a) no CFL deviation or a level bust is
detected at the same time, and
b) vertical latency time after a new vertical
clearance has been entered, and
c) the difference between AFL and CFL
exceeds a threshold, and
d) no minimum actual rate is detected into
the direction of the CFL or the actual rate
differs from the cleared vertical rate by more
than a parameter
04.07.02-OSED- | REQ-04.07.02- | Detection of a | The "TC aid" shall detect a Cleared Flight MONA
D19-02.00.00- OSED- CFL deviation |Level (CFL) deviation if the difference
REQ 0001.3022 between AFL and CFL exceeds a threshold.
04.07.02-OSED- | REQ-04.07.02- | Detection of a | The "TC aid" shall detect a Level Bust if the MONA
D19-02.00.00- OSED- Level Bust actual vertical rate for climb and/or descent
REQ 0001.3023 close to the CFL exceeds a threshold.
04.07.02-OSED- | REQ-04.07.02- | Detection of The "TC aid" shall detect a NoTT deviation if MONA
D19-02.00.00- OSED- unavailability |a) no valid flight plan data (route
REQ 0001.3024 of a Flight Plan | information) is available for a flight;
b) the aircraft is beyond or before its cleared
(filed) route.
04.07.02-OSED- | REQ-04.07.02- | Discard a route | The system shall discard a route deviation if MONA
D19-02.00.00- OSED- deviation a NoTT status has been detected.
REQ 0001.4037
04.07.02-OSED- | REQ-04.07.02- | Adherence of | The "TC aid" shall detect deviations MONA
D19-02.00.00- OSED- downlink between controller clearance data and Mode
REQ 0001.3026 parameters to | S DAP.
clearances
04.07.02-OSED- | REQ-04.07.02- | Detection of The "PC aid" shall alert the controller to any MONA
D19-02.00.00- OSED- deviations from | deviations from coordination conditions.
REQ 0002.4017 entry/exit
conditions
Table 6: P04.07.02 OSED allocated to P10.04.02
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907

Project ID 10.04.02
D44 - Consolidated Conformance Monitoring System Requirements

Subset of P04.07.02 SPR (D23) allocated to Functional Block MONA proposed by P10.04.02
partners and confirmed by P10.01.07 and finally adjusted after deliverable D23.

Edition: 00.04.00

SPR SPR SPR Requirement Text Functional
Requirement | Requirement Block
Identifier Title

REQ- Route deviation | The TC Aid shall create a deviation trajectory if Flight MONA
04.07.02- Path Monitoring detects a Route deviation.

SPR-

CDR1.1120

REQ- Lateral deviation |The TC Aid shall create a deviation trajectory if Flight MONA
04.07.02- Path Monitoring detects a Lateral deviation.

SPR-

CDR1.1130

REQ- Vertical rate The TC Aid shall create a deviation trajectory if Flight MONA
04.07.02- deviation Path Monitoring detects a Vertical Rate Deviation.

SPR-

CDR1.1140

REQ- CFL deviation The TC Aid shall create a deviation trajectory if Flight MONA
04.07.02- Path Monitoring detects a CFL deviation.

SPR-

CDR1.1150

REQ- Speed deviation | The TC Aid shall create a deviation trajectory if Flight MONA
04.07.02- Path Monitoring detects a Speed Deviation.

SPR-

CDR1.1160

REQ- No valid flight The TC Aid shall create a deviation trajectory if Flight MONA
04.07.02- plan data Path Monitoring detects that there is no valid flight plan

SPR- data available.

CDR1.1170

REQ- Tactical and The calculated trajectory shall be a Tactical Trajectory MONA
04.07.02- deviation if valid flight plan data is available and if no deviation,

SPR- trajectories as detected by Flight Path Monitoring occurred.

CDR1.1180 Otherwise it is referred to as a deviation trajectory.

REQ- HMI alert The TC Aid shall alert the controller to any deviations MONA
04.07.02- via HMI on the radar display.

SPR-

CDR1.1190

REQ- Continuous The TC Aid shall continuously monitor actual track MONA
04.07.02- monitoring data and controller clearance data.

SPR-

CDR1.1200

REQ- Remove The TC Aid shall detect if a deviation no longer exists MONA
04.07.02- deviation tag and remove the display of the alert to the controller.

SPR-

CDR1.1210

REQ- Mode S The TC Aid shall detect deviations between controller MONA
04.07.02- parameters clearance data and Mode S downlinked airborne

SPR- parameters.

CDR1.1220

REQ- Loss of TC Aid The probability of Loss of TC Aid shall be no more than MONA
04.07.02- 3.33E-07 per flight hour.

SPR-

CDR1.2030

REQ- Delay of TC Aid | The probability of Delay of the TC Aid shall be no more MONA
04.07.02- than 3.33E-07 per flight hour.

SPR-

CDR1.2070

REQ- Corruption of TC | The probability of Corruption (undetected) of the TC MONA
04.07.02- Aid (undetected) | Aid shall be no more than 3.33E-07 per flight hour.

SPR-

CDR1.2110
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SPR SPR SPR Requirement Text Functional
Requirement | Requirement Block
Identifier Title
REQ- Corruption of TC | The probability of Corruption (Detected) of the TC Aid MONA
04.07.02- Aid (detected) shall be no more than 1.00E-05 per flight hour.
SPR-
CDR1.2140
REQ- Deviating from The PC Aid shall alert the controller if the flight is MONA
04.07.02- the flight level deviating from the applied coordination constraints.
SPR- constraint
CDR2.1240
REQ- Spurious alerts The deviation alerts associated with coordination MONA
04.07.02- constraints shall be triggered at times/events
SPR- appropriate to the controller role.
CDR2.1250
Table 7: P04.07.02 SPR allocated to P10.04.02
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909 Appendix D Subset of P05.07.02 OSED, SPR and
910 INTEROP allocated to Functional Block MONA by
911 P10.04.02 partners
912  Subset of P05.07.02 D77 Preliminary V2 OSED for Step 1 allocated to Functional Block MONA
913  assumed by P10.04.02 partners .
OSED . . Functional
Identifier OSED Title OSED Requirement Block
REQ-05.07.02- | CMON — Radar | Radar data shall be the primary source of information
OSED- data primary for obtaining aircraft current position for conformance MONA
MCMO.2001 source monitoring purposes
REQ-05.07.02- [ CMON — For conformance monitoring purposes, the reference
OSED- Reference trajectory shall be the ground predicted trajecto MONA
MCMO.2003 | trajectory jectory g P jectory
REQ-05.07.02- gga?ar\ln;;aisst art For conformance monitoring purposes, the ground
OSED- of reference P predicted trajectory shall be updated continuously with MONA
MCMO.2004 - the last clearance/instruction provided by ATC.
trajectory
REQ-05.07.02- | CMON - Lateral | Conformance monitoring tool shall provide a lighting
OSED- deviation warning on the CWP when an aircraft is deviating its MONA
MCMO.2005 notification lateral navigation regarding ground predicted trajectory
g : _ . Conformance monitoring tool shall provide a lighting
REQ-05.07.02 CMQN vertical warning on the CWP when an aircraft does not meet the
OSED- i required vertical constraint regarding ground predicted i
MCMO.2006 notification trajectory
REQ-05.07.02- | CMON - STAR F{ying a STAtR, 'ft?\r conitqrmlance To.nittorfir:gtpurpgses;
OSED- constraint ator [ & & P e iy 2 warning ahall be - MONA
MCMO.2007 above 1590Vf$ ical tolerance for providing a warning shall be -
REQ-05.07.02- Flying a STAR, for conformance monitoring purposes,
OSED- T CMON - STAR | at a Waypoint with a vertical constraint of “at ”, the MONA
MCMO 2008 constraint at ;/temcal tolerance for providing a warning shall be + 150
. : _ Flying a STAR, for conformance monitoring purposes,
ggg;_ 5.07.02 Soh:(s)t'r\laints ;’2‘? at a Waypoint with a vertical constraint of “at or below”, MONA
MCMO.2009 below t1h5e0vf<tartlcal tolerance for providing a warning shall be +
REQ-05.07.02- | ~\ioN — direct | N @rrival, when the aircraft is cleared “direct to IAF” out
OSED- to IAF - MSA of a STAR., the vertical tolerance for providing a MONA
MCMO.2010 warning shall be - 150 ft of Minimum Sector Altitude.
REQ-05.07.02- CMON =SID Flying a SID, for conformance monitoring purposes, a
below 120 m : - . AP
OSED- above DER — no | Waming shall not be provided when aircraft is flying at or MONA
MCMO.2011 e below 120 m above DER.
notification
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OSED : : Functional
Identifier OSED Title OSED Requirement Block
CMON - SID Flying a SID, for conformance monitoring purposes,
REQ-05.07.02- 120 m above when the aircraft is flying between 120 m height above
OSED- DER below MSA DER and MSA, at a Waypoint with a vertical constraint MONA
MCMO.2012 at of “at ", the vertical tolerance for providing a warning
’ shall be + 100 ft
CMON - SID Flying a SID, for conformance monitoring purposes,
REQ-05.07.02- 120 m above when the aircraft is flying between 120 m height above
OSED- DER and MSA, at a Waypoint with a vertical constraint MONA
DER below MSA . » ; -
MCMO.2013 at or above of “at or above”, the vertical tolerance for providing a
’ warning shall be - 100 ft.
CMON - SID Flying a SID, for conformance monitoring purposes,
REQ-05.07.02- 120 m above when the aircraft is flying between 120 m height above
OSED- DER below MSA DER and MSA, at a Waypoint with a vertical constraint MONA
MCMO.2014 at or below of “at or below ", the vertical tolerance for providing a
) warning shall be + 100 ft.
REQ-05.07.02- Flying a SID, for conformance monitoring purposes,
OSED- e CMON - SID when the aircraft is flying above MSA, at a Waypoint MONA
above MSA . at | with a vertical constraint of “at ", the vertical tolerance
MCMO.2015 S -
for providing a warning shall be + 150 ft.
g _ _ Flying a SID, for conformance monitoring purposes,
gggé’_ 5.07.02 g&s:‘MSS/;D at when the aircraft is flying above MSA, at a Waypoint MONA
’ with a vertical constraint of “at or above ", the vertical
MCMO.2016 or above - .
tolerance for providing a warning shall be - 150 ft.
Flying a SID, for conformance monitoring purposes,
gggé’ 0raes ca:t’:::(\?gll\;sspl\D at |When the aircraftis flying above MSA, at a Waypoint MONA
y ’ with a vertical constraint of “at or below”, the vertical
MCMO.2017 or below - .
tolerance for providing a warning shall be + 150 ft.
REQ-05.07.02- CMON —lateral 2 For conformance monitoring purposes, the lateral
OSED- siama tolerance for providing a warning shall be the accuracy MONA
MCMO.2018 g of the PBN specification (+20)
REQ-05.07.02- CMON — CTA vs Conformance monitoring tool will provide a lighting
OSED- RTA deviation warning on the CWP when aircraft's CTA does not meet MONA
MCMO.2019 RTA over a particular waypoint
gggg’_ 5.07.02- CMON - time For conformance monitoring purposes, the time MONA
MCMO 2020 tolerance tolerance for providing a warning shall be £ X s.
REQ-05.07.02- | CMON - Actual - . N
oseD- " |IaSvs Clsarea | CoNemerce nonierng oSl e s e | wows
MCMO.2022 IAS deviation 9
. : _ Lateral tolerance which is used for providing a warning
gggoo. b gl\g(rjar\r:ceLateral by conformance monitoring tool shall be adaptable to MONA
MCMO 2024 considering PBN PBN_ spgcnﬁcatlon required for a particular PBN
application.
lounding mamber
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OSED : : Functional
Identifier OSED Title OSED Requirement Block
REQ-05.07.02- | CMON ~ Areratt | (2 EL8 T e tool shal provid a sbuler | 1,
MCMO.2025 EPP usage Lvarping indicating “in “xxx” minutes, “Flight ID” shall be
eviated from latest clearance.
914 Table 8: P05.07.02 OSED allocated to P10.04.02
915
916  Subset of P05.07.02 D78 Preliminary (V2) SPR for Step 1 allocated to Functional Block MONA
917  proposed by P10.04.02 partners.
918
SPR Identifier | SPR Title SPR Requirement Functional
Block
REQ- Minimum number of Flight Plans shall be 200
05.07.02-PR- MONA
XXXXXXXXXXX
REQ- The PC Aid shall automatically coordinate flights
05.07.02- into the sector without reference to the planner
SPR- controller when the coordination passes the MONA
CDR2.1140 MTCD check.
REQ- The frequency of occurrence of detected
05.07.02- corruption of input data from Trajectory
SR_Hz27 2 Deviation Detection function shall not be greater MONA
than 0.4x10-7(/lt hr)
REQ- The frequency of occurrence of undetected
05.07.02- corruption of input data from Trajectory
SR_Hz28 2 Deviation Detection function shall not be greater MONA
than 0.4x10-7(/t hr)
919 Table 9: P05.07.02 SPR allocated to P10.04.02
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920

921

922
923

924

925
926

927

Appendix E Requirements traceability to SESAR solution

Solution

Linked SPR (from P04.07.02 D63, D37)

Linked TS

#32: Free route through
the use of direct routing

REQ-04.07.02-SPR-DR00.0310

The frequency of occurrence of a loss of
route adherence monitoring tool in direct
routing environment shall not be greater
than 2.00E-03 per sector operational hour

REQ-10.04.02-TS-0001.0051
REQ-10.04.02-TS-0001.0010
REQ-10.04.02-TS-0001.0030

#33: Free route through
free routing for flights both
in cruise and vertically
evolving above a specified
flight level

REQ-04.07.02-OSED-FR04.0250

In Free Routing Airspace, the ATCOs shall
be supported by a MONA tool to monitor
the route adherence

REQ-10.04.02-TS-0001.0051
REQ-10.04.02-TS-0001.0010
REQ-10.04.02-TS-0001.0022
REQ-10.04.02-TS-0001.0030
REQ-10.04.02-TS-0001.0050

REQ-04.07.02-SPR-FRTA.0101

In Free Routing Airspace, the ATCOs shall
be supported by a MONA tool to monitor
the trajectory adherence

REQ-10.04.02-TS-0001.0051
REQ-10.04.02-TS-0001.0010
REQ-10.04.02-TS-0001.0022
REQ-10.04.02-TS-0001.0030
REQ-10.04.02-TS-0001.0050

REQ-04.07.02-SPR-FR00.0312

The frequency of occurrence of loss of
route adherence monitoring tool in FRA
shall not be greater than 2.00E-03 per
sector operational hour

REQ-10.04.02-TS-0001.0051
REQ-10.04.02-TS-0001.0010
REQ-10.04.02-TS-0001.0030

REQ-04.07.02-SPR-FRTA.1002

In Free Routing Airspace, the MONA shall
permanently and continuously check the
flight adherence to the cleared trajectory

REQ-10.04.02-TS-0001.0051
REQ-10.04.02-TS-0001.0010
REQ-10.04.02-TS-0001.0022

Table 10 - Traceability to SESAR solutions #32 and #33

All the other requirements not listed in the table above are linked to the Solution #27 Medium term

conflict detection (MTCD) and conformance monitor tools.
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Appendix F  Functional improvements on the top of
FASTI baseline

Requirements described in this document has as a starting point the FASTI baseline, that was
considered at the beginning of the SESAR program the state of the art for the Conformance
monitoring functional block.

A description of the new functionalities and features of SESAR Conformance Monitoring as an
improvement compared to FASTI and as contribution to Solution #27 are described in the following:

e heading monitoring: monitoring of lateral deviation while a heading clearance is provided; A
new Alert (CHAM) is provided when the flight is not conforming the issued clearance;

e rate monitoring: rate change, using of actual vertical rates, is taken into account during an
evolving phase when an aircraft is about to start its evolution or is about to reach its cleared
FL. The main aim is to minimize false alert by getting a more realistic prediction;

e Potential coordination failure monitoring;
e Comparison of Mode S DAP with clearance input from controllers;

e Detection of Level Bust.

Furthermore, the combination and availability of the tactical decision support tools together with the
conformance monitoring tool as a unique integrated system can also be considered as an innovation
respect to the initial baseline, whose potential in terms of KPA has been validated in the related
validation exercises.
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